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Preface 

Overview 

Thank you for choosing INVT FE series I/O system. 

INVT FE series I/O system is a flexible, reliable, and efficient signal transmission system with a more reliable 

structural design. The system is able to access to multiple standard communication networks, respond in 

microseconds, and equipped with rich signal modules to meet various industrial automation needs while 

saving cabinet space, helping you develop more competitive personalized solutions. 

Target audience 

Personnel with electrical professional knowledge (such as qualified electrical engineers or personnel with 

equivalent knowledge). 

About documentation obtaining 

In addition to this user guide, you can also obtain product documentation and technical support from our 

website: 

Visit www.invt.com, choose Support > Download, enter a keyword, and click Search. 

Change history 

The manual is subject to change irregularly without prior notice due to product version upgrades or other 

reasons. 

Version Release date Change description 

V1.0 January 2026 First release. 

https://www.invt.com/
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1 Safety precautions 

1.1 What this chapter contains 

Read this manual carefully and follow all safety precautions before moving, installing, operating and 

servicing the product. Otherwise, equipment damage or physical injury or death may be caused. 

We shall not be liable or responsible for any equipment damage or physical injury or death caused due to 

failure to follow the safety precautions. 

1.2 Safety level definition 

To ensure personal safety and avoid property damage, you must pay attention to the safety symbols and 

warnings in the manual. 

Warning 

symbol 
Name Description 

 Danger 
Severe personal injury or even death can result if related requirements 

are not followed. 

 Warning 
Personal injury or equipment damage can result if related requirements 

are not followed. 
 

1.3 Personnel requirements 

Trained and qualified professionals: People operating the equipment must have received professional 

electrical and safety training and obtained the certificates, and must be familiar with all steps and 

requirements of equipment installing, commissioning, running and maintaining and capable to prevent any 

emergencies. 

1.4 Safety guidelines 

General principles 

 

 Only trained and qualified professionals are allowed to carry out related 

operations. 

 Do not perform wiring, inspection or component replacement when power supply 

is applied. Ensure that all the input power supplies are disconnected before wiring 

and inspection. 

 The product design is applied to indoor electrical environments at overvoltage 

category II. Ensure that the power supply system of the product has lightning 

protection devices to prevent lightning overvoltage from being applied to the power 

input or signal I/O terminals of the product so as to avoid equipment damage. 

 Do not modify the product unless authorized; otherwise fire, electric shock or 

other injury may result. 

 Prevent metal scraps, copper wires, screws, cables, and other conductive objects 

from falling into the interior of the product. 

 Do not contact the product with damp objects or body parts. Otherwise, electric 

shock may result. 
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Moving 

 

 Select appropriate tools for product delivery, and take mechanical protective 

measures like wearing safety shoes and working uniforms to avoid personal 

injury. 

 Protect the product against physical shock or vibration. 
 

Installation 

 

 Do not install the product on inflammables. In addition, prevent the product from 

contacting or adhering to inflammables. 

 Do not run a damaged or incomplete product. 

 

 Install the product in a lockable control cabinet of at least IP20, which prevents 

the personnel without electrical equipment related knowledge from touching by 

mistake, since the mistake may result in equipment damage or electric shock. 

Only personnel who have received related electrical knowledge and equipment 

operation training can operate the control cabinet. 

 During installation, ensure that all the modules are tightly connected and 

fastened. Insecure connection may cause problems such as communication 

failure and fall-off. 

 After installation, ensure that there are no obstructions on the vents of the 

product; otherwise, the chips of the product may be burned due to overheating 

and poor heat dissipation, which causes system control failure and misoperation. 
 

Wiring 

 

 Before wiring, clearly understand the necessary information including interfaces, 

power supply types, and specifications, and comply with relevant standards and 

requirements to ensure that the system wiring is correct. 

 To ensure personal safety and equipment use safety, reliably ground the product 

using cables with proper diameters and specifications. 

 Route the control signal and communication signal cables separately from cables 

with strong interference such as power cables. 

 Secure long or heavy cables properly. 

 

 Cut off all power supplies connected to the product before performing wiring. 

 Before power-on for running, ensure that each module terminal cover is properly 

installed in place after the installation and wiring are completed. This prevents a 

live terminal from being touched. Otherwise, physical injury, equipment fault or 

misoperation may result. 

 Install proper protection components or devices when using external power 

supplies for the product. This prevents the product from being damaged due to 

external power supply faults, overvoltage, overcurrent, or other exceptions. 
 

Commissioning and running 

 

 Before power-on for running, ensure that the working environment of the product 

meets the requirements (see section 3.1.2 Installation environment and site for 

details), and a protection circuit has been designed to protect the product so that 

the product can run safely even if an external device fault occurs. 

 When the output units such as relays and transistors of the product are damaged, 

the output cannot be controlled to be On or Off as configured. 

 For modules or terminals requiring external power supply, configure external 

safety devices such as fuses or circuit breakers to prevent damage caused due to 

external power supply or device faults. 

 In the external circuit of the product, configure an emergency braking circuit, a 



FE Series I/O System User Manual  Safety precautions 

202601 (V1.0)  3 

Commissioning and running 

protection circuit, a circuit for interlocking between forward and reverse 

operations, and an anti-equipment-damage switch for interlocking between the 

position upper limit and lower limit. 

 To ensure the safe running of equipment, design external protection circuits and 

safety mechanisms for output signals related to major accidents. 

 In the event of a controller system failure, the output may become uncontrolled. 

To ensure normal operation of the equipment, appropriate external control 

circuits must be designed. 

 

Maintenance, servicing, and component replacement 

 

 Keep the product and its parts and components away from combustible materials 

and ensure they have no combustible materials adhered. 

 Before performing product maintenance, servicing, or component operations, 

disconnect all power supplies connected to the product. 

 During maintenance, servicing, or component replacement, prevent metal scraps, 

copper wires, screws, cables and other conductive parts from falling into the 

interior of the product. 

 During maintenance, servicing, or component replacement, take proper 

anti-static measures on the product and its internal parts. 

Note  Use proper torque to tighten screws. 
 

Disposal 

 
 The product contains heavy metals. Dispose of a scrap product as industrial 

waste. 

 
 Dispose of a scrap product separately at an appropriate collection point but not 

place it in the normal waste stream. 
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2 System overview 

2.1 System introduction 

The INVT FE series I/O system is a remote I/O expansion solution designed for signal acquisition and signal 

distribution control, applicable to a wide range of industrial automation applications. Featuring an open 

and modular architecture, the system supports multiple mainstream industrial fieldbus protocols and offers 

flexible configuration options, enabling seamless integration with various PLCs and controllers. 

By importing the device description file, module configuration can be completed directly within a 

third-party controller or supervisory system, eliminating the need for dedicated configuration software. The 

system is equipped with a 6Mbps backplane bus, enabling high-speed field data interaction. 

The product adopts two-sided clamp-on connection structure and gold plating process, has good corrosion 

resistance and contact reliability, the whole series is coated with three anti-paint, adapted to the harsh 

conditions. The compact module is only 12mm thick, effectively saving cabinet space; PUSH IN wiring 

improves wiring efficiency and enables quick tool-less installation. The module is clearly identified and the 

status indicator is intuitive for easy identification and maintenance. 

2.2 System components 

The FE series I/O system consists of communication couplers and a variety of function modules such as 

digital, analog, temperature acquisition, and process control modules), which can be flexibly configured 

according to the actual application requirements. 
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3 Installation 

3.1 Preparing 

3.1.1 Installation precautions 

Before installation 

 

 Make sure all the modules have been powered off before installation. 

 Check the planned overall size and ensure that there is enough space to 

accommodate all the modules. The product must be installed in a cabinet with 

each clearance to the surrounding greater than 50mm so that the product 

hardware has good heat dissipation. 
 

During installation 

 

 During installing, use the installation tools that meet the requirements, such as 

screws and gaskets. 

 Prevent metal wire heads, debris, screws, and other objects from falling into the 

interior of the product. Otherwise, short circuit may occur, or heat dissipation 

may be degraded. 
 

After installation 

 

 Ensure that all the communication cables, I/O signal cables, and wiring terminals 

are securely connected. 

 Ensure that the DIN rail that hosts the product is reliably fixed. 

 Ensure that the strong-electricity cables are separately routed from the 

weak-electricity cables, and the cables are routed neatly in the cabinet. 

 Remove the sticker attached to the heat dissipation hole of the product to make 

the heat dissipation smooth. 

 Check the air circulation around the product. 
 

3.1.2 Installation environment and site 

Check the installation environment and ensure that the environment meets the working conditions of all the 

components of the product, which include temperature, humidity, dust and corrosion protection 

requirements. 

Environmental requirements 

Environment Requirement 

Temperature 

 

-20℃–55℃ 

The temperature does not change rapidly. 

When the product is installed in a closed space, such as control 

cabinet, use a cooling fan for temperature adjustment if necessary. 

Humidity 
 

RH: 5% to 95%, no condensation 
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Site requirements 

Site Requirement 

Indoor 

overvoltage 

class II 

 
No strong electric field, strong magnetic field or direct sunlight 

 

No dust, conductive powder such as iron powder, oil mist, salt, or 

organic solvent 

 
No corrosive or flammable gas 

 

No factors that will cause the machine to directly vibrate or suffer 

conductive shocks 
 

3.1.3 Installation space 

Sufficient space should be reserved between the top and bottom of each module and the housing and other 

components to facilitate product replacement, ventilation, and heat dissipation. 

Figure 3-1 Installation space (unit: mm) 

5050 60

5
0

5
0

 

3.2 DIN rail model selection 

You can refer to the following table to select the applicable DIN rail model. 

Model Length × Depth (unit: mm) Fastening screw 

TH35-7.5Fe 35×7.5 M4 

TH35-7.5A1 35×7.5 M4 

TH35-15Fe 35×15 M4 
 

Figure 3-2 DIN rail installation dimensions (unit: mm) 

≤200≤200 ≤30

3
5

≤30 ≤200

DIN rail DIN rail installation bolt (user provided)
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Note: To ensure the strength of the DIN rail, install the DIN rail installation bolts (user provided) at the 

places within 30mm from both ends of the DIN rail, (for details, see Figure 3-2), and ensure that the interval 

between two adjacent bolts must be within 200mm. 

3.3 Installation procedure 

The installation procedure is as follows: 

Step 1 Slide the right end cover of the communication coupler forward and remove it. 

End cover

 

Step 2 Align the communication coupler module with the DIN rail and press inward until the module 

engages with the DIN rail (there is a noticeable sound of engagement when installed in place). 

DIN rail
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Step 3 Align the module with the connection rail with the sliding rail of the module fixed on the DIN rail, and 

push it inward until the module with the connection rail engages with the DIN rail (there is a 

noticeable sound of engagement when installed in place). 

Sliding slot

Connection slot

Sliding slot

 

Step 4 Slide the end cover with the connection rail onto the last I/O module. 

Sliding rail

Connection rail

Sliding rail

 

Note: The metal pins on the last I/O module must not be exposed outside. 
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Step 5 Install a guide rail fixing clip at the head and tail of the module assembly to prevent it from sliding 

leftward or rightward. 

End coverDIN rail fixing clip
 

Note: 

 Remove the end cover before installing the modules, and install the end cover on the rightmost module 

when the modules are installed. 

 After a module is installed, the DIN rail locking latch automatically engages. If the latch does not lock 

automatically, press the top of the locking latch toward the DIN rail to secure the module in place. 

 The DIN rail mounting clip is user supplied. 

 For detailed installation dimensions, see Appendix A Product dimensions. 

3.4 Disassembly procedure 

The disassembly steps are as follows: 

Step 1 Loosen the rail fixing clip to ensure that there is sufficient clearance to pull away the module from 

the DIN rail. 

Step 2 Use a slotted screwdriver or other similar tool to pry the DIN rail locking latch as shown in the 

following figure. 
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DIN rail latch Flat screwdriver

 

Step 3 Pull the module out in the direction perpendicular to the DIN rail. 

DIN rail

 

Note: Refer to section 3.3 Installation procedure to remove the end cover. 
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4 Wiring 

4.1 Wiring requirements 

 Before wiring, ensure that all external power supplies have been cut off. 

 After completing the wiring, ensure the module top end cover has been installed properly before 

powering on or operating the module. Otherwise, electric shock or maloperation can result. 

 Before wiring, check the rated voltage and terminal configuration according to product specifications 

to ensure safe wiring. The connection to a power supply that does not match the ratings or incorrect 

product wiring may cause serious accidents such as fire and product damage. 

 Tighten up screws according to specified torque. If screws are loose, short circuit, fire, or maloperation 

may result. 

Note: If terminal screws are too tightened, screw or module damage, falling, short circuit, or faults 

may result. 

 Ensure that there are no foreign objects such as metal scraps or wiring residues in each module. The 

foreign objects may cause short circuit, fire, or maloperation. 

4.2 Grounding requirements 

 Power cable grounding 

 Use correct, independent wiring methods. 

 Connect a cable with the cross-sectional area ≥2mm2 and length ≤30cm for grounding, and ground the 

power supply module terminal . 

 If the grounding point is close to the product, ensure that the grounding cable is secure. 

 Shielded cable grounding 

 Use shielded cables for analog I/O, RS485, and EtherCAT cables and other cables that transmit sensitive 

signals. 

 The grounding point should be as close as possible to the module. 

 For the shield part exposed after some of the shield cable is stripped, ground the part and the 

conductive backplane with an area as large as possible to ensure good contact. 

4.3 Cable specifications 

Cable material 

Cable diameter 

Crimping tool 
GB size (mm2) 

American wire 

gauge (AWG) 

Tubular cable 

lug 

0.3 22 

Use a proper crimping plier. 

0.5 20 

0.75 18 

1.0 18 

1.5 16 

Note: 
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 The cable diameters of the tubular cable lugs in the preceding table is only for reference, which can be 

adjusted based on actual situations. 

 When using other tubular cable lugs, crimp multiple strands of cable, and the processing size 

requirements are as follows: 

 



FE Series I/O System User Manual  Product specifications 

202601 (V1.0)  13 

5 Product specifications 

5.1 Overview 

This chapter provides a detailed description of the design, functions, interfaces, hardware specifications, 

software specifications, and environmental requirements of the communication couplers and I/O modules 

in the FE series I/O system. 

5.2 Basic information 

Model 
Ordering 

code 
Description Applicable to 

FE-EC 11016–00042 
Communication coupler, EtherCAT, 24VDC, 

RoHS 
EtherCAT master devices 

FE-PN 11016–00046 
Communication coupler, PROFINET, 24VDC, 

RoHS 

PROFINET master 

devices 

FE-1600D 11016–00041 
Digital input module, 16 channels, 

sourcing/sinking, 500mA@24VDC, RoHS 
INVT FE series products 

FE-0016N 11016–00043 
Digital output module, 16 channels of NPN 

transistor output, 500mA@24 VDC, RoHS 
INVT FE series products 

FE-0016P 11016–00040 
Digital output module, 16 channels of PNP 

transistor output, 500mA@24 VDC, RoHS 
INVT FE series products 

FE-4ADM 11016–00037 

Analog input module, 4 channels of voltage 

signal + 4 channels of current signal, 16-bit 

resolution, room temperature accuracy 

±0.15%FS, RoHS 

INVT FE series products 

FE-8ADV 11016–00036 

Analog input module, 8 channels, voltage 

signal, 16-bit resolution, room temperature 

accuracy ±0.15%FS, RoHS 

INVT FE series products 

FE-8ADI 11016–00038 

Analog input module, 8 channels, current 

signal, 16-bit resolution, room temperature 

accuracy ±0.15%FS, RoHS 

INVT FE series products 

FE-4DA 11016–00032 

Analogue output module, 4 channels, 16-bit 

resolution, room temperature accuracy 

±0.15%FS, RoHS 

INVT FE series products 

FE-4PT 11016–00035 
RTD module, 4 channels, 24-bit resolution, 

room temperature accuracy 0.1℃/℉, RoHS 
INVT FE series products 

FE-4TC 11016–00039 
Thermocouple input module, 4 channels, 

24-bit resolution, sensitivity 0.1℃/℉, RoHS 
INVT FE series products 

FE-0808N 11016–00034 

Digital I/O module, 8 channels of NPN 

transistor input, 8 channels of NPN transistor 

output, RoHS 

INVT FE series products 

FE-0808P 11016–00033 

Digital I/O module, 8 channels of PNP 

transistor input, 8 channels of PNP transistor 

output, RoHS 

INVT FE series products 
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5.3 Environmental requirements 

Item Specifications 

Working environment temperature -20℃–+55℃ 

Working environment relative 

humidity (RH) 
RH < 95%, without condensation 

Storage temperature -40℃–70℃ 

Storage environment RH RH < 90%, without condensation 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference level Zone B, compliant with IEC61131-2 

vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
 

5.4 Communication coupler 

5.4.1 EtherCAT communication coupler FE-EC 

Figure 5-1 FE-EC appearance 

0V0V

PEPE

24V24V

Power supply for unwired terminal

Unit Power Supply

FE-EC

Shenzhen INVT Electric Co.,Ltd.
Made in China

I06228000058

www.invt.com

EtherCAT Coupler / 24VDC
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Figure 5-2 Product components 

Status 
indicator

Smart key

EtherCAT port

24V power 
supply port

DIP switch

 

Table 5-1 Product component description 

Name Color 
Silk 

screen 
Description 

Power supply 

indicator 
Green PWR 

Off: The power connection is abnormal. 

On: The power connection is normal. 

Run indicator Green RUN 

Off: The communication coupler module is in INIT state. 

Blinking: The communication coupler module is 

Pre-Operational state. 

Single flash: The communication coupler module is in 

Safe-Operational state. 

On: The communication coupler module is in Operational 

state. 

Fault indicator Red ERR 

Off: The EtherCAT communication is in normal state. 

Blinking: An invalid EtherCAT state transition command has 

been received. 

Single flash: Network disconnection or a communication 

coupler module synchronization error has occurred. 
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Name Color 
Silk 

screen 
Description 

Double Flash: An EtherCAT communication watchdog error 

has occurred. 

Bus fault indicator Red SF 

Off: The device is operating normally. 

Slow flash (500ms): Configuration mismatch. 

Fast flash (100ms): Backplane bus initialization failed. 

On: Hardware failure – e2prom operation failed or ESC 

initialization failed. 

Backplane bus run 

indicator 
Green BRN 

Off: Initialization state or no power. 

Slow flash (500ms): Backplane bus is initializing. 

Fast flash (100ms): Backplane bus initialization successful, 

waiting for data communication. 

On: Backplane bus initialization successful, interacting with 

data. 

Backplane bus fault 

indicator 
Red BER 

Off: The backplane bus is running normally. 

Slow flash (500ms): Backplane communication timeout. 

On: The backplane bus has been unable to transmit or receive 

data for an extended period. 

Smart key Used to switch to factory mode and connect to the IO-Tools host controller. 

DIP switch 

Alias setting. The alias is set via an 8-bit binary hardware DIP switch, with a 

setting range of 1–255. 

The ON position of the DIP switch corresponds to logic "1". 

EtherCAT interface 
IN: EtherCAT input port 

OUT: EtherCAT output port 
 

 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

24V 24V 24V 24V 

0V 0V 0V 0V 

 PE PE  

 

 Terminal wiring 

Unit Power 
supply

(24VDC)

Power supply for 
unwired 
terminal

24V24V

0V 0V
 

 Hardware specifications 

Item Specifications 

Rated input voltage 24VDC (20.4VDC–28.8VDC) 

Rated input current 0.8A (Typical value at 24VDC) 

Backplane fieldbus 

output rated voltage 
5VDC (4.75VDC–5.25VDC) 

Backplane fieldbus 

output rated current 
2.5A (Typical value at 5VDC) 
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Item Specifications 

Isolation The input power is not isolated. 

Power supply protection Protection against overcurrent, reverse connection, and surges 
 

 Software specifications 

Item Specifications 

Alias access 
Supports EtherCAT alias access. Station alias can be set via a DIP switch, 

with an alias range of 1–255. 

Number of input/output 

PDOs 
Up to 1024 bytes 

Input/output mailbox 

size 
Up to 128 bytes 

Max. number of 

expansion modules 
32 

Supported min. 

synchronization interval 
1ms 

 

 Software user interface 

Type Name Type Default Description 

Configurat

ion 

parameter 

- - - - 

Input data 

iBus uint32_t - Backplane bus state machine 

ModuleStatus uint32_t - 

Module fault status (0: No module fault; 1: 

Module fault present) 

Bit0: Fault status of module 1 

Bit1: Fault status of module 2 

... 

Bit31: Fault status of module 32 

Note: The module fault codes can be obtained 

from the object dictionary 16 #3023. 

Output 

data 
- - - - 
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5.4.2 PROFINET communication coupler FE-PN 

Figure 5-3 FE-PN appearance 

FE-PN

Shenzhen INVT Electric Co.,Ltd.
Made in China

Profinet Coupler / 24VDC

www.invt.com

I06228000058

0V 0V

PEPE
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Power supply for unwired terminal

24V 24V

 

Figure 5-4 Product components 
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Table 5-2 Product component description 

Name Color 
Silk 

screen 
Description 

Power supply 

indicator 
Green PWR 

Off: The power connection is abnormal. 

On: The power connection is normal. 

Run indicator Green RUN 

Off: The communication coupler module is in Initialization 

state. 

Blinking (1000ms): Communication coupler module 

initialization completed, waiting for connection. 

Blinking (500ms): Communication coupler module 

connection established, waiting for configuration. 

Blinking (100ms): Communication coupler module 

configuration completed, waiting for cyclic data interaction. 

On: The communication coupler module is in cyclic data 

exchange state. 

Fault indicator Red ERR 

Off: The communication coupler module is in normal state. 

Blinking (500ms): Expansion module fault. 

Blinking (100ms): PROFINET communication timeout. 

Bus fault indicator Red SF 

Off: The device is operating normally. 

Slow flash (500ms): Configuration mismatch. 

Fast flash (100ms): Backplane bus initialization failed. 

On: Hardware fault. 

Backplane bus run 

indicator 
Green BRN 

Off: Initialization state or no power. 

Slow flash (500ms): Backplane bus is initializing. 

Fast flash (100ms): Backplane bus initialization successful, 

waiting for data communication. 

On: Backplane bus initialization successful, interacting with 

data. 

Backplane bus fault 

indicator 
Red BER 

Off: The backplane bus is running normally. 

Slow flash (500ms): Backplane communication timeout. 

On: The backplane bus has been unable to transmit or receive 

data for an extended period. 

Smart key Used to switch to factory mode and connect to the IO-Tools host controller. 

DIP switch 

PN device name setting. The alias is set via an 8-bit binary hardware DIP switch, 

with a setting range of 1–255. 

The ON position of the DIP switch corresponds to logic "1". 

PROFINET interface 
P1: Ethernet interface 1 

P2: Ethernet interface 2 
 

 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

24V 24V 24V 24V 

0V 0V 0V 0V 

 PE PE  
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 Terminal wiring 

Unit Power 
supply

(24VDC)

Power supply for 
unwired 
terminal

24V24V

0V 0V
 

 Hardware specifications 

Item Specifications 

Rated input voltage 24VDC (20.4VDC–28.8VDC) 

Rated input current 0.8A (Typical value at 24VDC) 

Backplane fieldbus 

output rated voltage 
5VDC (4.75VDC–5.25VDC) 

Backplane fieldbus 

output rated current 
2.5A (Typical value at 5VDC) 

Isolation The input power is not isolated. 

Power supply protection Protection against overcurrent, reverse connection, and surges 
 

 Software specifications 

Item Specifications 

Communication mode RT mode 

Min. communication 

period 

1ms 

I&M data From I&M0 to I&M3 

PROFINET version V2.4 

Expansion capability Supports expansion of up to 32 modules 

PROFINET interface 

quantity 
2 

PROFINET switch 

function 
Supports networking 

Open IE support Supports TCP/IP and LLDP 

I/O cyclic data exchange 

size 
≤1440Byte 

Alarm/Diagnosis/Status 

information 
Supports local diagnostic information upload to the PLC 

Physical layer 100BASE-TX 

Communication rate 10 Mbit/s or 100 Mbit/s (adaptive) 

Communication mode Full-duplex (auto-negotiation) 

Topology structure Line, star, tree, ring (MRP), etc. 
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5.5 I/O module 

5.5.1 Digital input module FE-1600D 

Figure 5-5 FE-1600D appearance 
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Table 5-3 Product component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for communication 

to be established. 

Slow flash (500ms): The module is establishing communication. 

Fast flash (100ms): Module communication established, waiting 

for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Input signal 

indicator 

(For each input) 

Green 
00–07 

10–17 

On: The input is valid. 

Off: The input is invalid. 

User terminal External wiring I/O terminal 
 

 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

DI0 A0 B0 DI10 

DI1 A1 B1 DI11 

DI2 A2 B2 DI12 

DI3 A3 B3 DI13 

DI4 A4 B4 DI14 

DI5 A5 B5 DI15 

DI6 A6 B6 DI16 

DI7 A7 B7 DI17 

SS A8 B8 SS 
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 Terminal wiring 

DI0

DI7

DI10

DI17

In
te

rn
a
l circu

it

SS

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

24VDC24VDC

Source inputSink input

 

 Power supply specifications 

Item Specifications 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
80mA (Typical value at 5VDC) 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

 Input specifications 

Item Specifications 

Input type Digital input 

Input mode Sourcing/sinking 

Input channel 16 

Input voltage class 24VDC±10% (21.6VDC–26.4VDC) 
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Item Specifications 

Input current (typical) 5mA (Typical value at 24VDC) 

ON voltage >15V 

OFF voltage <5V 

Hardware response time 

ON/OFF 
300μs/300μs 

Software filter time Supported 

Input resistance Reference value about 5.2kΩ 

Isolated Yes 

Input action display When the input is in driving state, the input indicator is on. 

Input derating 

When operating at an ambient temperature of 55°C, derate to 75% (no 

more than 12 inputs ON simultaneously), or reduce the ambient 

temperature by 10°C when all inputs are ON. 
 

 Software specifications 

Item Specifications 

Software input filter time 

Set range: 0–255 (Default: 3) 

Unit: 1ms, e.g. 10 = 10ms 

Able to set two groups of filter parameter. Every eight channels use a 

group of filter parameter. 

Input port exception 

detection and indication 
None 

Input channel logic level 

configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output will not be refreshed, while input supports refreshing in 

Safe-operational state. 

I/O mapping 

Via two XML files: 

Bit-access mapping supported 

Byte-access mapping supported 
 

 Software user interface 

Type Name Type Default Description 

Configur

ation 

paramet

er 

IB0 Filt uint8_t 3 [0, 255], unit: 1ms, e.g. 3 = 3ms 

IB1 Filt uint8_t 3 [0, 255], unit: 1ms, e.g. 3 = 3ms 

Input 

data 

IB0 uint8_t - I00–I07 sample values 

IB1 uint8_t - I10–I17 sample values 

Output 

data 
- - - - 
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5.5.2 Digital output module (sourcing) FE-0016P 

Figure 5-7 FE-0016P appearance 
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Table 5-4 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for 

communication to be established. 

Slow flash (500ms): The module is establishing 

communication. 

Fast flash (100ms): Module communication established, 

waiting for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Output signal 

indicator 

(For each output) 

Green 
00–07 

10–17 

On: Output enabled. 

Off: Output disabled. 

User terminal External wiring I/O terminal 
 

 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

DO0 A0 B0 DO10 

DO1 A1 B1 DO11 

DO2 A2 B2 DO12 

DO3 A3 B3 DO13 

DO4 A4 B4 DO14 

DO5 A5 B5 DO15 

DO6 A6 B6 DO16 

DO7 A7 B7 DO17 

24V A8 B8 0V 
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 Terminal wiring 

In
te
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l c
irc

u
it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

24V

DO17

DO10

DO7

DO0

 

 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 60mA 

Terminal input power rated voltage 24VDC (20.4VDC–28.8VDC) 

Terminal input power rated current 2A (Typical value at 24VDC) 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

 Output specifications 

Item Specifications 

Output type Digital output, high-edge output 

Power-off output The module output is turned off after the coupler or CPU is powered off. 

Output mode Source type 

Output channel 16 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load (Resistive 

load) 
0.5A/point, 2A/module 

Output load (Inductive 

load) 
7.2W/point, 12W/module 

Output load (Light load) 5W/point, 18W/module 

Hardware response time 

ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 100Hz for resistive load, 0.5Hz for inductive load, and 10Hz for lamp load 

Isolated Yes 

Output action display When the output is in driving state, the output indicator is on. 
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Item Specifications 

Output derating 

At an ambient temperature of 55°C, the load must be derated to 50% 

(take resistive load for example: with all output channels ON 

simultaneously, the output current shall not exceed 1A). 

At an ambient temperature of 45°C, full load operation is permitted (take 

resistive load for example: with all output channels ON simultaneously, 

the output current shall not exceed 2A). 

Protection functions Short-circuit protection and overcurrent protection 
 

 Software specifications 

Item Specifications 

Stop/offline output mode Outputs are held or set to preset values, configurable per output point. 

Preset value of stop/offline 

output 
Single-point 0 or 1 

Output channel exception 

detection indication 
Overheat/overcurrent detection on a module basis 

Output channel logic level 

configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of diagnosis 

reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

IO mapping 

Via two XML files: 

Bit-access mapping supported 

Byte-access mapping supported 
 

 Software user interface 

Type Name Type Default Description 

Configuration 

parameter 

QB0 Out Mode uint8_t 0 

Q00–Q07 output mode (0: Output preset; 1: Hold 

output) 

Bit0: Q00 output mode 

Bit1: Q01 output mode 

... 

Bit7: Q07 output mode 

QB0 Preset 

Value 
uint8_t 0 Q00–Q07 output preset values 

QB1 Out Mode uint8_t 0 

Q10–Q17 output mode (0: Output preset; 1: Hold 

output) 

Bit0: Q10 output mode 

Bit1: Q11 output mode 

... 

Bit7: Q17 output mode 

QB1 Preset 

Value 
uint8_t 0 Q10–Q17 output preset values 

Input data - - - - 

Output data QB0 uint8_t - Q00–Q07 output value 
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Type Name Type Default Description 

QB1 uint8_t - Q10–Q17 output value 
 

The digital output module divides every eight channels into a group. Taking QB0 Out Mode as an example, 

the data type is uint8_t. Each bit defines the output mode of one output point, where bit0–bit7 correspond 

to output channels Q00–Q07, respectively. 

The value of each bit corresponding to an output channel indicates the output mode:  

0: Output the preset value on stop/offline. 

1: Hold the output on stop/offline. 

For example: If Q00–Q01 are set to hold output on stop/offline (bit0–bit1 set to 1), and Q02–Q07 are set to 

output preset values on stop/offline (bit2–bit7 set to 0), then the value of QB0 Out Mode is 3, that is, 

0b00000011. Q02–Q07 output preset values are configured by QB0 Preset Value [Bit7–Bit2]. 

bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

0 0 0 0 0 0 1 1 
 

5.5.3 Digital output module (sinking) FE-0016N 

Figure 5-9 FE-0016N appearance 

Made in China

FE-0016N

www.invt.com

I06228000058
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Figure 5-10 Product components 
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Table 5-5 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for 

communication to be established. 

Slow flash (500ms): The module is establishing 

communication. 

Fast flash (100ms): Module communication established, 

waiting for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Output signal 

indicator 

(For each output) 

Green 
00–07 

10–17 

On: Output enabled. 

Off: Output disabled. 

User terminal External wiring I/O terminal 
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 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

DO0 A0 B0 DO10 

DO1 A1 B1 DO11 

DO2 A2 B2 DO12 

DO3 A3 B3 DO13 

DO4 A4 B4 DO14 

DO5 A5 B5 DO15 

DO6 A6 B6 DO16 

DO7 A7 B7 DO17 

24V A8 B8 0V 

 Terminal wiring 
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24VDC

LOAD

LOAD

LOAD

LOAD

COM

DO17

DO10

DO7

DO0

24V

 

 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 60mA 

Terminal input power rated voltage 24VDC (20.4VDC–28.8VDC) 

Terminal input power rated current 100mA (Typical value at 24VDC) 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
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 Output specifications 

Item Specifications 

Output type Digital output, low-edge output 

Power-off output The module output is turned off after the coupler or CPU is powered off. 

Output mode Sink 

Output channel 16 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load (Resistive 

load) 
0.5A/point, 4A/module 

Output load (Inductive 

load) 
7.2W/point, 24W/module 

Output load (Lamp load) 5W/point, 18W/module 

Hardware response time 

ON/OFF 
100μs 

Leakage current at OFF 10μA 

Switch frequency 100Hz for resistive load, 0.5Hz for inductive load, and 10Hz for lamp load 

Isolated Yes 

Output action display When the output is in driving state, the output indicator is on. 

Output derating 

At an ambient temperature of 55°C, the load must be derated to 50% 

(take resistive load for example: with all output channels ON 

simultaneously, the output current shall not exceed 2A). 

At an ambient temperature of 45°C, full load operation is permitted (take 

resistive load for example: with all output channels ON simultaneously, 

the output current shall not exceed 4A). 

Protection functions Short-circuit protection and overcurrent protection 
 

 Software specifications 

Item Specifications 

Stop/offline output mode Outputs are held or set to preset values, configurable per output point. 

Preset value of stop/offline 

output 
Single-point 0 or 1 

Output channel exception 

detection indication 
Overheat/overcurrent detection and protection on a module basis 

Output channel logic level 

configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of diagnosis 

reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

IO mapping 

Via two XML files: 

Bit-access mapping supported 

Byte-access mapping supported 
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 Software user interface 

Type Name Type Default Description 

Configuration 

parameter 

QB0 Out Mode uint8_t 0 

Q00–Q07 output mode (0: Output preset; 1: Hold 

output) 

Bit0: Q00 output mode 

Bit1: Q01 output mode 

... 

Bit7: Q07 output mode 

QB0 Preset 

Value 
uint8_t 0 Q00–Q07 output preset values 

QB1 Out Mode uint8_t 0 

Q10–Q17 output mode (0: Output preset; 1: Hold 

output) 

Bit0: Q10 output mode 

Bit1: Q11 output mode 

... 

Bit7: Q17 output mode 

QB1 Preset 

Value 
uint8_t 0 Q10–Q17 output preset values 

Input data - - - - 

Output data 
QB0 uint8_t - Q00–Q07 output values 

QB1 uint8_t - Q10–Q17 output value 
 

The digital output module divides every eight channels into a group. Taking QB0 Out Mode as an example, 

the data type is uint8_t. Each bit defines the output mode of one output point, where bit0–bit7 correspond 

to output channels Q00–Q07, respectively. 

The value of each bit corresponding to an output channel indicates the output mode:  

0: Output the preset value on stop/offline. 

1: Hold the output on stop/offline. 

For example: If Q00–Q01 are set to hold output on stop/offline (bit0–bit1 set to 1), and Q02–Q07 are set to 

output preset values on stop/offline (bit2–bit7 set to 0), then the value of QB0 Out Mode is 3, that is, 

0b00000011. Q02–Q07 output preset values are configured by QB0 Preset Value [Bit7–Bit2]. 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

0 0 0 0 0 0 1 1 
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5.5.4 Mixed digital module (sourcing) FE-0808P 

Figure 5-11 FE-0808P appearance 
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Figure 5-12 Product components 
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Table 5-6 Product component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for 

communication to be established. 

Slow flash (500ms): The module is establishing 

communication. 

Fast flash (100ms): Module communication established, 

waiting for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Input signal 

indicator 

(For each input) 

Green 00–07 
On: The input is valid. 

Off: The input is invalid. 

Output signal 

indicator 

(For each output) 

Green 10–17 
On: Output enabled. 

Off: Output disabled. 

User terminal External wiring I/O terminal 

 

 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

DI0 A0 B0 DO0 

DI1 A1 B1 DO1 

DI2 A2 B2 DO2 

DI3 A3 B3 DO3 

DI4 A4 B4 DO4 

DI5 A5 B5 DO5 

DI6 A6 B6 DO6 

DI7 A7 B7 DO7 

24V A8 B8 0V 
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 Terminal wiring 

Equivalent circuit
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 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 80mA (Typical value at 5VDC) 

Terminal input power rated voltage 24VDC (20.4VDC–28.8VDC) 

Terminal input power rated current 2A (Typical value at 24VDC) 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

 Input/output specifications 

Item Specifications 

Input specifications 

Input type Digital input 

Input mode Source type 

Input channel 8 

Input voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Input current (typical) 5mA (Typical value at 24VDC) 

ON voltage >15V 

OFF voltage <5V 

Hardware response time 

ON/OFF 
300μs/300μs 

Software filter time Supported 

Input resistance Reference value about 5.2kΩ 

Isolated Yes 
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Item Specifications 

Input action display When the input is in driving state, the input indicator is on. 

Input derating 

When each terminal is operating at 55℃, it is derated to 75% (with no 

more than 6 input points of ON at the same time), or the temperature 

drops by 10℃ when all input points are ON. 

Output specifications 

Output type Digital output, high-edge output 

Power-off output The module output is turned off after the coupler or CPU is powered off. 

Output mode Source type 

Output channel 8 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load (Resistive 

load) 
0.5A/point, 2A/module 

Output load (Inductive 

load) 
7.2W/point, 12W/module 

Output load (Lamp load) 5W/point, 9W/module 

Hardware response time 

ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 100Hz for resistive load, 0.5Hz for inductive load, and 10Hz for lamp load 

Isolated Yes 

Output action display When the output is in driving state, the output indicator is on. 

Output derating 

At an ambient temperature of 55°C, the load must be derated to 50% (take 

resistive load for example: with all output channels ON simultaneously, 

the output current shall not exceed 1A). 

At an ambient temperature of 45°C, full load operation is permitted (take 

resistive load for example: with all output channels ON simultaneously, 

the output current shall not exceed 2A). 

Protection functions Short-circuit protection and overcurrent protection 

 Software specifications 

Item Specifications 

Software input filter time 

Setting range: 0–255 (Default: 3) 

Unit: 1ms, e.g. 10 = 10ms 

One filter parameter is shared by a group of 8 channels. 

Input port exception 

detection and indication 
Overheat/overcurrent detection and protection on a module basis 

Input channel logic level 

configuration 
Not supported 

Stop/offline output mode Outputs are held or set to preset values, configurable per output point. 

Preset value of 

stop/offline output 
Single-point 0 or 1 

Output channel 

exception detection 

indication 

Overheat/overcurrent detection and protection on a module basis 

Output channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 
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Item Specifications 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

I/O mapping Supporting the mapping method of bitwise access 
 

 Software user interface 

Type Name Type Default Description 

Configurat

ion 

parameter 

IB0 Filt uint8_t 3 [0, 255], unit: 1ms, e.g. 3 = 3ms 

QB0 Out Mode uint8_t 0 

Q00–Q07 output mode (0: Output preset; 1: Hold 

output) 

Bit0: Q00 output mode 

Bit1: Q01 output mode 

... 

Bit7: Q07 output mode 

QB0 Preset Value uint8_t 0 Q00–Q07 output preset values 

Input data IB0 uint8_t - I00–I07 sample values 

Output 

data 
QB0 uint8_t - Q00–Q07 output values 

 

5.5.5 Mixed digital module (sinking) FE-0808N 

Figure 5-13 FE-0808N appearance 
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Figure 5-14 Product components 

Color
Status indicator

Input signal 
indicator Output signal 

indicator

User terminal

 

Table 5-7 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run status 

indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for 

communication to be established. 

Slow flash (500ms): The module is establishing 

communication. 

Fast flash (100ms): Module communication established, 

waiting for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Input signal indicator 

(For each input) 
Green 00–07 

On: The input is valid. 

Off: The input is invalid. 

Output signal 

indicator 

(For each output) 

Green 10–17 
On: Output enabled. 

Off: Output disabled. 

User terminal External wiring I/O terminal 
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 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

DI0 A0 B0 DO0 

DI1 A1 B1 DO1 

DI2 A2 B2 DO2 

DI3 A3 B3 DO3 

DI4 A4 B4 DO4 

DI5 A5 B5 DO5 

DI6 A6 B6 DO6 

DI7 A7 B7 DO7 

24V A8 B8 0V 

 

 Terminal wiring 

Equivalent circuit

DI0

DI3

DI4

DI7

In
te

rn
a

l c
irc

u
it

24V

Optocoupler 

isolation

24VDC
24V

LOAD

LOAD

LOAD

LOAD

COM

DO17

DO10

DO7

DO0

Optocoupler 

isolation

Optocoupler 

isolation

Optocoupler 

isolation

 

 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 80mA (Typical value at 5VDC) 
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Item Specifications 

Terminal input power rated voltage 24VDC (20.4VDC–28.8VDC) 

Terminal input power rated current 100mA (Typical value at 24VDC) 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

 Input/output specifications 

Item Specifications 

Input specifications 

Input type Digital input 

Input mode Sink 

Input channel 8 

Input voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Input current (typical) 5mA (Typical value at 24VDC) 

ON voltage >15V 

OFF voltage <5V 

Hardware response time 

ON/OFF 
300μs/300μs 

Software filter time Supported 

Input resistance Reference value about 5.2kΩ 

Isolated Yes 

Input action display When the input is in driving state, the input indicator is on. 

Input derating 

When operating at an ambient temperature of 55°C, derate to 75% (no 

more than 6 inputs ON simultaneously), or reduce the ambient 

temperature by 10°C when all inputs are ON. 

Output specifications 

Output type Digital output, low-edge output 

Power-off output The module output is turned off after the coupler or CPU is powered off. 

Output mode Sink 

Output channel 8 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load (Resistive 

load) 
0.5A/point, 2A/module 

Output load (Inductive 

load) 
7.2W/point, 12W/module 

Output load (Lamp load) 5W/point, 9W/module 

Hardware response time 

ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 100Hz for resistive load, 0.5Hz for inductive load, and 10Hz for lamp load 

Isolated Yes 

Output action display When the output is in driving state, the output indicator is on. 

Output derating 

At an ambient temperature of 55°C, the load must be derated to 50% (take 

resistive load for example: with all output channels ON simultaneously, 

the output current shall not exceed 1A). 

At an ambient temperature of 45°C, full load operation is permitted (take 

resistive load for example: with all output channels ON simultaneously, 
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Item Specifications 

the output current shall not exceed 2A). 

Protection functions Short-circuit protection and overcurrent protection 
 

 Software specifications 

Item Specifications 

Software input filter 

time 

Setting range: 0–255 (Default: 3) 

Unit: 1ms, e.g. 10 = 10ms 

One filter parameter is shared by a group of 8 channels. 

Input port exception 

detection and 

indication 

None 

Input channel logic 

level configuration 
Not supported 

Stop/offline output 

mode 
Outputs are held or set to preset values, configurable per output point. 

Preset value of 

stop/offline output 
Single-point 0 or 1 

Output channel 

exception detection 

indication 

Overheat/overcurrent detection and protection on a module basis 

Output channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

I/O mapping Supporting the mapping method of bitwise access 
 

 Software user interface 

Type Name Type Default Description 

Configuration 

parameter 

IB0 Filt uint8_t 3 [0, 255], unit: 1ms, e.g. 3 = 3ms 

QB0 Out Mode uint8_t 0 

Q00–Q07 output mode 

Bit0: Q00 output mode 

Bit1: Q01 output mode 

... 

Bit7: Q07 output mode 

0: Output preset; 1: Hold output 

QB0 Preset Value uint8_t 0 Q00–Q07 output preset values 

Input data IB0 uint8_t - I00–I07 sample values 

Output data QB0 uint8_t - Q00–Q07 output values 
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5.5.6 Analog input module FE-4ADM 

Figure 5-15 FE-4ADM appearance 
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Table 5-8 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowi

sh 

green 

R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for communication 

to be established. 

Slow flash (500ms): The module is establishing 

communication. 

Fast flash (100ms): Module communication established, 

waiting for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Channel status 

indicator 
Green 00–07 

Off: The channel is disabled. 

Slow flash (500ms): Input signal overrange or channel 

configuration parameter error. 

Fast flash (100ms): Hardware error – Internal chip SPI 

communication timeout. 

On: Channel enabled 

User terminal External wiring I/O terminal 

 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

V0+ A0 B0 V0- 

V1+ A1 B1 V1- 

V2+ A2 B2 V2- 

V3+ A3 B3 V3- 

I0+ A4 B4 I0- 

I1+ A5 B5 I1- 

I2+ A6 B6 I2- 

I3+ A7 B7 I3- 

PE A8 B8 PE 

 

 Terminal wiring 

Figure 5-17 Voltage input wiring 
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Cable shield 
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e
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Figure 5-18 Current input wiring 
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 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 130mA 

Terminal input power rated voltage None 

Terminal input power rated current None 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

 Input specifications 

Input type Item Specifications 

Voltage 

input 

Input type Analog input 

Input mode Voltage (Differential) 

Input channel 4 

Resolution 16 bits 

Conversion time <170μs/channel 

Voltage input range 0–5V, 0–10V, -5–+5V, -10–+10V, 1–5V 

Voltage input resistance 1MΩ 

Voltage input accuracy (25℃) ±0.15% 

Voltage input accuracy (in full 

temperature range) 
±0.3% 

Current 

input 

Input type Analog input 

Input mode Current (Differential) 

Input channel 4 

Resolution 16 bits 

Conversion time <170μs/channel 

Current input range ±20mA, 0–20mA, 4–20mA 

Current input resistance 240Ω 

Current input accuracy (25℃) ±0.15% 

Current input accuracy (in full ±0.3% 
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Input type Item Specifications 

temperature range) 

Current input limit ± 30mA 
 

 Software specifications 

Item Specifications 

Configuration of independent 

channel enabling 
Supported 

Configuration of diagnosis 

reporting 
Supported 

Configuration of enabling 

diagnosis detection 
Over range detection 

Mode switchover configuration 
Voltage: 0–5V, 0–10V, ±5V, ±10V, 1–5V 

Current: 4–20mA, 0–20mA, ±20mA 

Filter parameter configuration 
Software filter time can be set through the upper computer, which 

ranges from 0 to 255, with the sampling period as the unit. 

Configuration of enabling peak 

holding 
Not supported 

Configuration 

of conversion 

digital range 

-10–+10VDC -20000–20000, -32000–32000, -27648–27648, -32768–32767 

0–10VDC 0–20000, 0–32000, 0–27648, 0–32767 

-5–+5VDC -20000–20000, -32000–32000, -27648–27648, -32768–32767 

0–5VDC 0–20000, 0–32000, 0–27648, 0–32767 

1–5VDC 0–20000, 0–32000, 0–27648, 0–32767 

-20mA–+20mA -20000–20000, -32000–32000, -27648–27648, -32768–32767 

0mA–20mA 0–20000, 0–32000, 0–27648, 0–32767 

4mA–20mA 0–20000, 0–32000, 0–27648, 0–32767 

Sampling time <170μs/channel 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period 

based synchronous refresh 
 

 Software user interface 

Type Name Type Default Description 

Configurat

ion 

parameter 

AI0 Cfg uint8_t 0x61 

Configuration parameter for channel 0. 

Bit0: Channel enable 

Bit1: Overrange detection enable 

Bit2: Enhanced filter enable 

bit4–bit3: Conversion range selection 

2#00: (0–20000) or (-20000–20000) 

2#01: (0–27648) or (-27648–27648) 

2#10: (0–32000) or (-32000–32000) 

2#11:(0–32767) or (-32768–32767) 

Bit7–Bit5: Conversion mode selection 

2#000: voltage 0–5V 

2#001: voltage 0–10V 

2#010: voltage -5–5V 

2#011: voltage -10–10V 

2#100: voltage 1–5V 

AI0 Filt uint8_t 8 Channel filter queue size 

AI1 Cfg uint8_t 0x61 Same definition as channel 0 configuration 
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Type Name Type Default Description 

parameter. 

AI1 Filt uint8_t 8 Channel filter queue size 

AI2 Cfg uint8_t 0x61 
Same definition as channel 0 configuration 

parameter. 

AI2 Filt uint8_t 8 Channel filter queue size 

AI3 Cfg uint8_t 0x61 
Same definition as channel 0 configuration 

parameter. 

AI3 Filt uint8_t 8 Channel filter queue size 

AI4 Cfg uint8_t 0xA1 

Configuration parameter for channel 4. 

Bit0: Channel enable 

Bit1: Overrange detection enable 

Bit2: Enhanced filter enable 

bit4–bit3: Conversion range selection 

2#00: (0–20000) or (-20000–20000) 

2#01: (0–27648) or (-27648–27648) 

2#10: (0–32000) or (-32000–32000) 

2#11:(0–32767) or (-32768–32767) 

Bit7–Bit5: Conversion mode selection 

2#101: Current 4–20mA 

2#110: Current 0–20mA 

2#111: Current -20–20mA 

AI4 Filt uint8_t 8 Channel filter queue size 

AI5 Cfg uint8_t 0xA1 
Same definition as channel 4 configuration 

parameter. 

AI5 Filt uint8_t 8 Channel filter queue size 

AI6 Cfg uint8_t 0xA1 
Same definition as channel 4 configuration 

parameter. 

AI6 Filt uint8_t 8 Channel filter queue size 

AI7 Cfg uint8_t 0xA1 
Same definition as channel 4 configuration 

parameter. 

AI7 Filt uint8_t 8 Channel filter queue size 

Input data 

AI0 int16_t - Channel sample code value 

AI1 int16_t - Channel sample code value 

AI2 int16_t - Channel sample code value 

AI3 int16_t - Channel sample code value 

AI4 int16_t - Channel sample code value 

AI5 int16_t - Channel sample code value 

AI6 int16_t - Channel sample code value 

AI7 int16_t - Channel sample code value 

Output 

data 
- - - - 

 

AIx_Cfg (x = 0, 1, 2, 3, 4, 5, 6, 7) is a channel configuration parameter. The parameter type is uint8_t. For the 

FE-4ADM module, channels 0–3 support voltage input only, while channels 4–7 support current input only. 

The following takes configuring channel 0 as an example. 

Channel 0 is configured with channel enabled, overrange detection enabled, enhanced filter disabled, a 

converted digital range of 0–20000, and a measurement range of 1–5V. The corresponding value is 131 

(0b10000011). The detailed bit definition is shown in the following: 
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Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

100 00 0 1 1 

1–5V 0–20000 Disable Enabled Enabled 
 

AIx_Filt (x=0, 1, 2, 3, 4, 5, 6, 7) is the channel filter parameter setting. The parameter type is uint8_t. The 

parameter setting range is 0 to 255. Generally, a higher value indicates better suppression of high-frequency 

interference, but it also leads to greater delay. It should be adjusted according to the actual situation. 

5.5.7 Analog input module FE-8ADV 

Figure 5-19 FE-8ADV appearance 
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Figure 5-20 Product components 

Status 
indicator

Color

User 
terminal

Signal 
indicator

 

Table 5-9 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for 

communication to be established. 

Slow flash (500ms): The module is establishing 

communication. 

Fast flash (100ms): Module communication established, 

waiting for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Channel status 

indicator 
Green 00–07 

Off: The channel is disabled. 

Slow flash (500ms): Input signal overrange or channel 

configuration parameter error. 

Fast flash (100ms): Hardware error – Internal chip SPI 

communication timeout. 

On: Channel enabled 

User terminal External wiring I/O terminal 
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 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

V0+ A0 B0 V0- 

V1+ A1 B1 V1- 

V2+ A2 B2 V2- 

V3+ A3 B3 V3- 

V4+ A4 B4 V4- 

V5+ A5 B5 V5- 

V6+ A6 B6 V6- 

V7+ A7 B7 V7- 

PE A8 B8 PE 

 

 Terminal wiring 

Figure 5-21 Voltage input wiring 
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V0-
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shield layer

F
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e
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o
rk  

 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 130mA 

Terminal input power rated voltage None 

Terminal input power rated current None 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

 Input specifications 

Item Specifications 

Input type Analog input 

Input mode Voltage (Differential) 

Input channel 8 

Resolution 16 bits 

Conversion time <170μs per channel 

Voltage input range 0–5V, 1–5V, 0–10V, -5–+5V, -10–+10V 

Voltage input resistance 1MΩ 

Voltage input accuracy 

(25℃) 
±0.15% 

Voltage input accuracy (in ±0.3% 
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Item Specifications 

full temperature range) 

Isolated 
No isolation between interface channels; voltage isolated from interface; 

interface isolated from bus 
 

 Software specifications 

Item Specifications 

Configuration of independent 

channel enabling 
Supported 

Configuration of diagnosis 

reporting 
Supported 

Configuration of enabling 

diagnosis detection 
Over range detection 

Mode switchover configuration 0–5V, 0–10V, ±5V, ±10V, 1–5V 

Filter parameter configuration 
Software filter time can be set through the upper computer, which 

ranges from 0 to 255, with the sampling period as the unit. 

Overrange detection enable 

configuration 
Supported 

Configuration of enabling peak 

holding 
Not supported 

Configuration 

of conversion 

digital range 

-10–+10VDC -20000–20000, -32000–32000, -27648–27648, -32768–32767 

0–10VDC 0–20000, 0–32000, 0–27648, 0–32767 

-5–+5VDC -20000–20000, -32000–32000, -27648–27648, -32768–32767 

0–5VDC 0–20000, 0–32000, 0–27648, 0–32767 

1–5VDC 0–20000, 0–32000, 0–27648, 0–32767 

Sampling time <170μs/channel 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period 

based synchronous refresh 

 Software user interface 

Type Name Type Default Description 

Configuration 

parameter 

AI0 Cfg uint8_t 0x61 

Configuration parameter for channel 0. 

Bit0: Channel enable 

Bit1: Overrange detection enable 

Bit2: Enhanced filter enable 

bit4–bit3: Conversion range selection 

2#00: (0–20000) or (-20000–20000) 

2#01: (0–27648) or (-27648–27648) 

2#10: (0–32000) or (-32000–32000) 

2#11:(0–32767) or (-32768–32767) 

Bit7–Bit5: Conversion mode selection 

2#000: voltage 0–5V 

2#001: voltage 0–10V 

2#010: voltage -5–5V 

2#011: voltage -10–10V 

2#100: voltage 1–5V 

2#101: reserved 

2#110: reserved 

2#111: reserved 

AI0 Filt uint8_t 8 Channel filter queue size 
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Type Name Type Default Description 

AI1 Cfg uint8_t 0x61 Same definition as channel 0 configuration parameter. 

AI1 Filt uint8_t 8 Channel filter queue size 

AI2 Cfg uint8_t 0x61 Same definition as channel 0 configuration parameter. 

AI2 Filt uint8_t 8 Channel filter queue size 

AI3 Cfg uint8_t 0x61 Same definition as channel 0 configuration parameter. 

AI3 Filt uint8_t 8 Channel filter queue size 

AI4 Cfg uint8_t 0x61 Same definition as channel 0 configuration parameter. 

AI4 Filt uint8_t 8 Channel filter queue size 

AI5 Cfg uint8_t 0x61 Same definition as channel 0 configuration parameter. 

AI5 Filt uint8_t 8 Channel filter queue size 

AI6 Cfg uint8_t 0x61 Same definition as channel 0 configuration parameter. 

AI6 Filt uint8_t 8 Channel filter queue size 

AI7 Cfg uint8_t 0x61 Same definition as channel 0 configuration parameter. 

AI7 Filt uint8_t 8 Channel filter queue size 

Input data 

AI0 int16_t - Channel sample code value 

AI1 int16_t - Channel sample code value 

AI2 int16_t - Channel sample code value 

AI3 int16_t - Channel sample code value 

AI4 int16_t - Channel sample code value 

AI5 int16_t - Channel sample code value 

AI6 int16_t - Channel sample code value 

AI7 int16_t - Channel sample code value 

Output data - - - - 
 

5.5.8 Analog input module FE-8ADI 

Figure 5-22 FE-8ADI appearance 

Shenzhen INVT Electric Co.,Ltd.
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Figure 5-23 Component description 

Status 
indicator

Color

User 
terminal

Signal 
indicator

 

Table 5-10 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for 

communication to be established. 

Slow flash (500ms): The module is establishing 

communication. 

Fast flash (100ms): Module communication established, 

waiting for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Channel status 

indicator 
Green 00–07 

Off: The channel is disabled. 

Slow flash (500ms): Input signal overrange or channel 

configuration parameter error. 

Fast flash (100ms): Hardware error – Internal chip SPI 

communication timeout. 

On: Channel enabled 

User terminal External wiring I/O terminal 
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 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

I0+ A0 B0 I0- 

I1+ A1 B1 I1- 

I2+ A2 B2 I2- 

I3+ A3 B3 I3- 

I4+ A4 B4 I4- 

I5+ A5 B5 I5- 

I6+ A6 B6 I6- 

I7+ A7 B7 I7- 

PE A8 B8 PE 

 Terminal wiring 

Figure 5-24 Current input wiring 
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Cable shield 
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-
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+

Power
24VDC

I0+

I0-
Cable shield 

layer

Three-wire system 4-20mA 
sensor/transmitter

8ADI 
module

+

-

+

-

Power
24VDC

I0+

I0-
Cable shield 

layer

Four-wire system 
4-20mA sensor/transmitter

8ADI 
module

+

-

+

Power
24VDC -

S-

S+

+ S
-

 

 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 130mA 

Terminal input power rated voltage None 

Terminal input power rated current None 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
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 Input specifications 

Item Specifications 

Input type Analog input 

Input mode Current (Differential) 

Input channel 8 

Resolution 16 bits 

Conversion time <170μs/channel 

Current input range ±20mA, 0–20mA, 4–20mA 

Current input resistance 240Ω 

Current input accuracy 

(25℃) 
±0.15% 

Current input accuracy (in 

full temperature range) 
±0.3% 

Current input limit ± 30mA 

Isolated 
No isolation between interface channels; voltage isolated from interface; 

interface isolated from bus 
 

 Software specifications 

Item Specifications 

Configuration of independent 

channel enabling 
Supported 

Configuration of diagnosis 

reporting 
Supported 

Configuration of enabling 

diagnosis detection 
Over range detection 

Mode switchover 

configuration 
4–20mA, 0–20mA, ±20mA 

Filter parameter configuration 
Software filter time can be set through the upper computer, which 

ranges from 1 to 255, with the sampling period as the unit. 

Configuration of enabling 

over-limit detection 
Supported 

Configuration of enabling 

peak holding 
Not supported 

Configuration 

of conversion 

digital range 

 

-20mA–20mA -20000–20000, -32000–32000, -27648–27648, -32768–32767 

0mA–20mA 0–20000, 0–32000, 0–27648, 0–32767 

4mA–20mA 0–20000, 0–32000, 0–27648, 0–32767 

Sampling time <170μs/channel 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period 

based synchronous refresh 

 

 Software user interface 

Type Name Type Default Description 

Configuration 

parameter 
AI0 Cfg uint8_t 0xA1 

Configuration parameter for channel 0. 

Bit0: Channel enable 

Bit1: Overrange detection enable 

Bit2: Enhanced filter enable 

bit4–bit3: Conversion range selection 

2#00: (0–20000) or (-20000–20000) 
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Type Name Type Default Description 

2#01: (0–27648) or (-27648–27648) 

2#10: (0–32000) or (-32000–32000) 

2#11:(0–32767) or (-32768–32767) 

Bit7–Bit5: Conversion mode selection 

2#000: reserved 

2#001: reserved 

2#010: reserved 

2#011: reserved 

2#100: reserved 

2#101: Current 4–20mA 

2#110: Current 0–20mA 

2#111: Current -20–20mA 

AI0 Filt uint8_t 8 Channel filter queue size 

AI1 Cfg uint8_t 0xA1 Same definition as channel 0 configuration parameter. 

AI1 Filt uint8_t 8 Channel filter queue size 

AI2 Cfg uint8_t 0xA1 Same definition as channel 0 configuration parameter. 

AI2 Filt uint8_t 8 Channel filter queue size 

AI3 Cfg uint8_t 0xA1 Same definition as channel 0 configuration parameter. 

AI3 Filt uint8_t 8 Channel filter queue size 

AI4 Cfg uint8_t 0xA1 Same definition as channel 0 configuration parameter. 

AI4 Filt uint8_t 8 Channel filter queue size 

AI5 Cfg uint8_t 0xA1 Same definition as channel 0 configuration parameter. 

AI5 Filt uint8_t 8 Channel filter queue size 

AI6 Cfg uint8_t 0xA1 Same definition as channel 0 configuration parameter. 

AI6 Filt uint8_t 8 Channel filter queue size 

AI7 Cfg uint8_t 0xA1 Same definition as channel 0 configuration parameter. 

AI7 Filt uint8_t 8 Channel filter queue size 

Input data 

AI0 int16_t - Channel sample code value 

AI1 int16_t - Channel sample code value 

AI2 int16_t - Channel sample code value 

AI3 int16_t - Channel sample code value 

AI4 int16_t - Channel sample code value 

AI5 int16_t - Channel sample code value 

AI6 int16_t - Channel sample code value 

AI7 int16_t - Channel sample code value 

Output data - - - - 
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5.5.9 Analog output module FE-4DA 

Figure 5-25 FE-4DA appearance 

 

Figure 5-26 Product components 

Color

Status indicator

Signal indicator

User terminal
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Table 5-11 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for communication to 

be established. 

Slow flash (500ms): The module is establishing communication. 

Fast flash (100ms): Module communication established, waiting 

for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Channel status 

indicator 
Green 00–03 

Off: The channel is disabled. 

Slow flash (500ms): Current disconnection, voltage short circuit, 

or channel configuration parameter error. 

Fast flash (100ms): Hardware error – Internal chip SPI 

communication timeout, or no 24V supply. 

On: Channel enabled 

User terminal External wiring I/O terminal 
 

 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

V0+ A0 B0 VI0- 

I0+ A1 B1 PE 

V1+ A2 B2 VI1- 

I1+ A3 B3 PE 

V2+ A4 B4 VI2- 

I2+ A5 B5 PE 

V3+ A6 B6 VI3- 

I3+ A7 B7 PE 

24V A8 B8 COM 
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 Terminal wiring 

COM

24V

PE

I0+

VI0-

V0+

CH0

PE

I1+

VI1-

V1+

CH1

PE

I2+

VI2-

V2+

CH2

PE

I3+

VI3-

V3+

CH3

24VDC external DC power

Current output mode
Drivable load range: 

0–0.6kΩ

Voltage output mode
Drivable load range: 

1kΩ–1MΩ

Power 
chip

Digital-
analog 

conversion

5V

+15V

-15V

Cable shield layer 

Cable shield layer 

 

 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 100mA 

Terminal input power rated voltage 24VDC (20.4VDC–28.8VDC) 

Terminal input power rated current 100mA (Typical value at 24VDC) 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 

 Output specifications 

Item Specifications 

Output type Analog output 

Output mode Voltage/current 

Output channel 4 

Resolution 16 bits 

Conversion time 40μs/channel 

Voltage output range 0–5V, 0–10V, -5–+5V, -10–+10V 

Voltage output load 1kΩ 

Voltage output accuracy 

(25℃) 
±0.3% 

Voltage output accuracy (in 

full temperature range) 
±0.5% 

Voltage output diagnosis Supports short circuit detection 

Current output range 0–20mA, 4–20mA 

Current output load <600Ω 

Current output accuracy 

(25℃) 
±0.3% 
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Item Specifications 

Current output accuracy (in 

full temperature range) 
±0.5% 

Current output diagnosis Supports open circuit detection. 

Isolated No isolation between interface channels; interface isolated from bus. 

Output action display None 

Output derating None 
 

 Software specifications 

Item Specifications 

Configuration of 

independent channel 

enabling 

Supported 

Configuration of diagnosis 

reporting 
Supported 

Configuration of enabling 

diagnosis detection 
Detects voltage output short circuit and current output open circuit. 

Mode switchover 

configuration 
0–5V, 0–10V, ±5V, ±10V, 4–20mA, 0–20mA 

Output status configuration 

after stop 
The current output is hold or the preset value is output. 

Preset value output after 

stop 
Supported 

Configuration 

of conversion 

digital range 

0–5V 0–20000, 0–27648, 0–32000, 0–32767 

0–10V 0–20000, 0–27648, 0–32000, 0–32767 

± 5V -20000–20000, -27648–27648, -32000–32000, -32768–32767 

± 10V -20000–20000, -27648–27648, -32000–32000, -32768–32767 

0–20mA 0–20000, 0–27648, 0–32000, 0–32767 

4–20mA 0–20000, 0–27648, 0–32000, 0–32767 

Sampling time 160μs for 4 channels 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period based 

synchronous refresh 

Stop mode 
Output according to the fault-caused stop mode or the preset value, 

without refreshing any more 
 

 Software user interface 

Type Name Type Default Description 

Configuration 

parameter 
AO0 Cfg uint16_t 0x60 

Configuration parameter for channel 0. 

Bit0: Channel enable 

Bit1: Output fault detection enable 

Bit2: Output mode 

2#0: Output preset 

2#1: Hold output 

bit4–bit3: Conversion range selection 

2#00: (0–20000) or (-20000–20000) 

2#01: (0–27648) or (-27648–27648) 

2#10: (0–32000) or (-32000–32000) 

2#11:(0–32767) or (-32768–32767) 

Bit7–Bit5: Conversion mode selection 
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Type Name Type Default Description 

2#000: voltage 0–5V 

2#001: voltage 0–10V 

2#010: voltage -5–5V 

2#011: voltage -10–10V 

2#100: reserved 

2#101: Current 4–20mA 

2#110: Current 0–20mA 

2#111: reserved 

bit15–bit8: Reserved 

AO0 Preset 

Value 
int16_t 0 Channel safety output preset value 

AO1 Cfg uint16_t 0x60 Same definition as channel 0 configuration parameter. 

AO1 Preset 

Value 
int16_t 0 Channel safety output preset value 

AO2 Cfg uint16_t 0x60 Same definition as channel 0 configuration parameter. 

AO2 Preset 

Value 
int16_t 0 Channel safety output preset value 

AO3 Cfg uint16_t 0x60 Same definition as channel 0 configuration parameter. 

AO3 Preset 

Value 
int16_t 0 Channel safety output preset value 

Input data - - - - 

Output data 

AO0 int16_t - Channel output code value 

AO1 int16_t - Channel output code value 

AO2 int16_t - Channel output code value 

AO3 int16_t - Channel output code value 
 

AOx Cfg (x=0, 1, 2, 3) is a channel configuration parameter. The parameter type is uint16_t.  

The following takes configuring channel 0 as an example. 

Channel 0 is configured as channel enabled, output fault detection enabled, preset value output on offline, 

conversion range 0–20000, and channel conversion mode is set to 4–20mA. The value should be 163, that is, 

0b10100011. Details are as follows: 

Bit15–Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

Reserved 0b101 0b00 0 1 1 

Reserved 4–20mA 0–20000 
Output preset 

on offline 
Enabled Enabled 
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5.5.10 Temperature detection module (RTD) FE-4PT 

Figure 5-27 FE-4PT appearance 

I2+ 4 I2-

BA

Shenzhen INVT Electric Co.,Ltd.

4xAnalog Input,temperature,RTD,24bit

I06228000058

www.invt.com

FE-4PT

Made in China

I3-

R2-

PE

R3-

I3+ 6

5

7

8PE

R3+

R2+

I1+

R1+

R0+

I0+

I1-

1

0

2

3 R1-

I0-
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Four-wire
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Figure 5-28 Product components 

Status 
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Table 5-12 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for 

communication to be established. 

Slow flash (500ms): The module is establishing 

communication. 

Fast flash (100ms): Module communication established, 

waiting for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Channel status 

indicator 
Green 00–03 

Off: The channel is disabled. 

Slow flash (500ms): Input signal overrange/disconnected 

Fast flash (100ms): Hardware exception 

On: Channel enabled 

User terminal External wiring I/O terminal 
 

 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

I0+ A0 B0 I0- 

R0+ A1 B1 R0- 

I1+ A2 B2 I1- 

R1+ A3 B3 R1- 

I2+ A4 B4 I2- 

R2+ A5 B5 R2- 

I3+ A6 B6 I3- 

R3+ A7 B7 R3- 

PE A8 B8 PE 
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 Terminal wiring 

Filter

I+

R+

R-

I-

Filter

AGND

Filter

I+

R+

R-

I-

Filter

AGND

Filter

I+

R+

R-

I-

Filter

AGND

PT

PT

PT

Two-wire 
PT

Three-wire 
PT

Four-wire 
PT

FG

FG

FG

 

 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 130mA 

Terminal input power rated voltage None 

Terminal input power rated current None 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

 Input specifications 

Item Specifications 

Input channel 4 

Resolution 24 bits 

Input terminals Four RTD inputs 

Sensor type PT100, PT500, PT1000, Cu100 

Wiring method Two-wire/Three-wire/Four-wire 

Accuracy (room 

temperature 25°C) 
Full scale * ± 0.3% 

Accuracy (room 

temperature -20℃–

+55℃) 

Full scale * ± 0.5% 

Sampling period 

Channel 1 and channel 2 form a group, while channel 3 and channel 4 form 

a group. When both channels within a group are enabled and one channel is 

configured as a three-wire system, the sampling period is 720ms per 

channel, and in other cases, the sampling period is 240ms per channel. 

Filter parameter 0–255 (Default: 8). Unit: Sampling period 
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Item Specifications 

Isolation method 
I/O terminals insulated from the power supply;  

No insulation between channels 
 

 Software specifications 

Item Specifications 

Configuration of 

diagnosis reporting 
Supported 

Configuration of 

enabling diagnosis 

detection 

Supports overrange detection and disconnection detection. 

Independent channel 

configuration 
Supported 

Sampling period 

Channel 1 and channel 2 form a group, while channel 3 and channel 4 form 

a group. 

When both channels within a group are enabled and one channel is 

configured as a three-wire system, the sampling period is 720ms per 

channel, and in other cases, the sampling period is 240ms per channel. 

Display mode Celsius degree (℃), Fahrenheit degree (℉) 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period based 

synchronous refresh 

Disconnection or 

overrange 
Output of max. value plus 1℃. Disconnection detection supported. 

System diagnosis Not supported 

Channel diagnosis Disconnect alarm/Overrange alarm 

Software diagnosis Supported 
 

 Software user interface 

Type Name Type Default Description 

Configuration 

parameter 

PT0 Cfg uint8_t 0x11 

Configuration parameter for channel 0. 

Bit0: Channel enable 

Bit1: Overrange detection enable 

Bit2: Disconnection detection enable 

Bit3: Temperature unit 

2#0: ℃ 

2#1:℉ 

Bit5–Bit4: RTD wire system 

2#00: Two-wire system 

2#01: Three-wire system 

2#10: Four-wire system 

Bit7–Bit6: Sensor type selection 

2#00: Pt100 

2#01: Pt500 

2#10: Pt1000 

2#11: Cu100 

PT0 Filt uint8_t 8 Channel filter queue size 

PT1 Cfg uint8_t 0x11 Same definition as channel 0 configuration parameter. 

PT1 Filt uint8_t 8 Channel filter queue size 

PT2 Cfg uint8_t 0x11 Same definition as channel 0 configuration parameter. 
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Type Name Type Default Description 

PT2 Filt uint8_t 8 Channel filter queue size 

PT3 Cfg uint8_t 0x11 Same definition as channel 0 configuration parameter. 

PT3 Filt uint8_t 8 Channel filter queue size 

Input data 

PT0 real32_t - Temperature sampling value 

PT1 real32_t - Temperature sampling value 

PT2 real32_t - Temperature sampling value 

PT3 real32_t - Temperature sampling value 

Output data - - - - 
 

PTx Cfg (x=0, 1, 2, 3) is a channel configuration parameter. The parameter type is USINT.  

The following takes configuring channel 0 as an example. 

Channel 0 is configured as follows: channel enabled, overrange detection enabled, disconnection detection 

enabled, temperature unit ℃ selected, RTD three-wire system selected, and PT1000 selected as sensor type. 

The PT0 Cfg value should be 97, that is, 0b10010111. Details are as follows: 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

10 01 0 1 1 1 

PT1000 Three-wire system ℃ Enabled Enabled Enabled 
 

PTx Filt (x=0, 1, 2, 3) is a channel filter parameter. The parameter type is USINT and the parameter setting 

range is 1–255. Generally, a higher value indicates better suppression of high-frequency interference, but it 

also leads to greater delay. It should be adjusted according to the actual situation. 

5.5.11 Temperature detection module (thermocouple) FE-4TC 

Figure 5-29 FE-4TC appearance 
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Made in China
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NC NC

PE 8

7
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TC2+ TC2-2

TC3+ TC3-
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Figure 5-30 Product components 

Status 
indicator

Color

User 
terminal

Signal 
indicator

 

Table 5-13 Component description 

Name Color 
Silk 

screen 
Description 

Power-on/Run 

status indicator 

Yellowish 

green 
R 

Off: The module is not powered on or it is abnormal. 

Slow flash (1000ms): The module is waiting for communication 

to be established. 

Slow flash (500ms): The module is establishing communication. 

Fast flash (100ms): Module communication established, waiting 

for data interaction. 

On: The module is in data interaction. 

Module fault 

indicator 
Red E 

Off: The module works normally. 

Slow flash (500ms): Backplane communication timeout. 

Fast flash (100ms): Backplane voltage too low. 

On: A module fault has occurred. 

Channel status 

indicator 
Green 00–03 

Off: The channel is disabled. 

Slow flash (500ms): Input signal overrange/disconnected 

Fast flash (100ms): Hardware exception 

On: Channel enabled 

User terminal External wiring I/O terminal 
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 Terminal definition 

Diagram Left signal Left terminal Right terminal Right signal 

 

TC0+ A0 B0 TC0- 

TC1+ A1 B1 TC1- 

TC2+ A2 B2 TC2- 

TC3+ A3 B3 TC3- 

- A4 B4 - 

- A5 B5 - 

- A6 B6 - 

- A7 B7 - 

- A8 B8 - 

 

 Terminal wiring 

Filter
TC+

TC-
TCTC

FGCable shield 
layer Shield 

ground

 

 Power supply specifications 

Item Specifications 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 120mA 

Terminal input power rated voltage None 

Terminal input power rated current None 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

 Input specifications 

Item Specifications 

Input channel 4 

Resolution 24 bits 

Input terminals 4 thermocouple inputs 

Thermocouple type E, J, K, T 

Compensation method Internal cold junction compensation 

Accuracy (room 

temperature 25°C) 
Full scale * (±0.1%) + Cold junction compensation error 
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Item Specifications 

Accuracy (room 

temperature -20℃–+55℃) 
Full scale * (±0.3%) + Cold junction compensation error 

Isolated 
I/O terminals insulated from the power supply; 

No insulation between channels 

Input action display None 

Input derating None 

Over-limit and 

disconnection detection 
Supports overrange detection and disconnection detection. 

 

 Cold junction compensation 

Installation direction Cold junction compensation error (-20℃–+55℃) 

Horizontal and upright installation ±3℃ 

Non-horizontal but upright installation ±6℃ 
 

 Software specifications 

Item Specifications 

Configuration of diagnosis 

reporting 
Supported 

Configuration of enabling 

diagnosis detection 
Supports overrange detection and disconnection detection. 

Sensor type configuration Thermocouple types supported: E, J, K, T 

Filter parameter 0–255 (Default: 8) 

Independent channel 

configuration 
Supported 

Sampling period 360ms per channel 

Display mode Celsius degree (℃), Fahrenheit degree (℉) 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period based 

synchronous refresh 

Disconnection or over-limit Output of max. value plus 1℃ 

System diagnosis Not supported 

Channel diagnosis Disconnect alarm/Overrange alarm 

Software diagnosis Supported 
 

 Software user interface 

Type Name Type Default Description 

Configuration 

parameter 
TC0 Cfg uint8_t 0x01 

Configuration parameter for channel 0. 

Bit0: Channel enable 

Bit1: Overrange detection enable 

Bit2: Disconnection detection enable 

Bit3: Temperature unit 

2#0: ℃ 

2#1: ℉ 

Bit5–Bit4: Reserved 

Bit7–Bit6: Sensor type selection 
2#00: Type K thermocouple (Type N thermocouple) 

2#01: Type J thermocouple (Type R thermocouple) 

2#10: Type T thermocouple (Type S thermocouple) 

2#11: Type E thermocouple (Type B thermocouple) 
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Type Name Type Default Description 

TC0 Filt uint8_t 8 Channel filter queue size 

TC1 Cfg uint8_t 0x01 Same definition as channel 0 configuration parameter. 

TC1 Filt uint8_t 8 Channel filter queue size 

TC2 Cfg uint8_t 0x01 Same definition as channel 0 configuration parameter. 

TC2 Filt uint8_t 8 Channel filter queue size 

TC3 Cfg uint8_t 0x01 Same definition as channel 0 configuration parameter. 

TC3 Filt uint8_t 8 Channel filter queue size 

Input data 

TC0 real32_t - Temperature sampling value 

TC1 real32_t - Temperature sampling value 

TC2 real32_t - Temperature sampling value 

TC3 real32_t - Temperature sampling value 

Output data - - - - 
 

TCx Cfg (x=0, 1, 2, 3) is a channel configuration parameter. The parameter type is USINT.  

The following takes configuring channel 0 as an example. 

Channel 0 is configured as follows: channel enabled, overrange detection enabled, disconnection detection 

enabled, temperature unit ℃ selected, and type J thermocouple selected as sensor type. The TC0 Cfg value 

should be 47, that is, 0b01000111. Details are as follows: 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

01 00 0 1 1 1 

Type J thermocouple - ℃ Enabled Enabled Enabled 
 

TCx Filt (x=0, 1, 2, 3) is a channel filter parameter. The parameter type is USINT and the parameter setting 

range is 1–255. Generally, a higher value indicates better suppression of high-frequency interference, but it 

also leads to greater delay. It should be adjusted according to the actual situation. 
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6 Coupler use instructions 

6.1 EtherCAT communication coupler 

Table 6-1 Software interface description 

Type Name Type Default Description 

Configuration 

parameter 
- - - - 

Input data 

iBus uint32_t - Backplane bus state machine 

ModuleStatus uint32_t - 

Module fault status (0: No module fault; 1: Module 

fault present) 

Bit0: Fault status of module 1 

Bit1: Fault status of module 2 

... 

Bit31: Fault status of module 32 

Note: The module fault codes can be obtained 

from the object dictionary 16 #3023. 

Output data - - - - 
 
 
 

Table 6-2 Object dictionary description 

16#3010 

Station address 

uint16_t sub index 1 Configured station address 

uint16_t sub index 2 Configured station alias 

uint16_t sub index 3 Coded station alias 

16#3011 

IN port error counters 

uint8_t sub index 1 Invalid frame counter 

uint8_t sub index 2 Physical layer receive error counter 

uint8_t sub index 3 Forwarding error counter 

uint8_t sub index 4 Link-loss counter 

16#3012 

OUT port error counters 

uint8_t sub index 1 Invalid frame counter 

uint8_t sub index 2 Physical layer receive error counter 

uint8_t sub index 3 Forwarding error counter 

uint8_t sub index 4 Link-loss counter 

16#3013 

ESC error counters 

uint8_t sub index 1 Data frame processing error counter 

uint8_t sub index 2 PDI error 

uint8_t sub index 3 Process data watchdog timeout 

uint8_t sub index 4 PDI watchdog timeout 

16#3020 

Coupler basic information 

uint16_t sub index 1 Hardware version 

uint16_t sub index 2 Software version 

uint8_t sub index 3 Configured module count 

uint8_t sub index 4 Actual module count 

uint32_t sub index 5 Coupler fault code 
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16#3021 

Module hardware type information 

uint8_t sub index 1 Module 1 hardware type 

uint8_t sub index 2 Module 2 hardware type 

... ... 

uint8_t sub index 32 Module 32 hardware type 

16#3022 

Module software version information 

uint8_t sub index 1 Module 1 software version 

uint8_t sub index 2 Module 2 software version 

... ... 

uint8_t sub index 32 Module 32 software version 

16#3023 

Module fault code information 

uint16_t sub index 1 Module 1 fault code 

uint16_t sub index 2 Module 2 fault code 

... ... 

uint16_t sub index 32 Module 32 fault code 

16#3030 

Backplane end station related information 

uint32_t sub index 1 Backplane transmit frame counter 

uint32_t sub index 2 Backplane receive valid frame counter 

uint32_t sub index 3 Backplane receive error frame counter 

uint32_t 
sub index 4 Backplane receive consecutive error 

frame counter 
 

6.1.1 CODESYS configuration description 

6.1.1.1 Installing the device description file 

From the menu bar, choose Tools > Device Repository. In the Device Repository window, click Install, 

locate the device description file, and then click Open. 

Note: If the installation of the device description file fails, try changing the CODESYS language setting to 

Chinese and then perform the installation again. 
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6.1.1.2 Performing network configuration 

Step 1 Add EtherCAT_Master_SoftMotion. 

Right-click Device, and choose Add Device. In the Add Device window, choose Fieldbuses > 

EtherCAT > EtherCAT_Master_SoftMotion, and then click Add Device. 

Note: After adding the EtherCAT master, configure the master source MAC address. 
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Step 2 Add EtherCAT Slave. 

Right-click EtherCAT_Master_SoftMotion, and choose Add Device. In the Add Device window, 

choose the coupler slave you want to add, and click Add Device. 

 

 

Step 3 Add the expansion module. 

Right-click the added coupler slave, and choose Add Device. In the Add Device window, choose the 

module you want to add, and click Add Device. 

 

Note: The physical configuration must be consistent with the network configuration. If the configuration 

is inconsistent, EtherCAT communication cannot enter the OP state. 
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6.1.1.3 EtherCAT communication parameter configuration 

Step 1 Set the synchronization mode: Double-click the added coupler slave, and click the General tab. Set 

Select DC under Distributed Clock. 

 

 

Step 2 Set the synchronization cycle: Double-click EtherCAT_Master_SoftMotion, and click the General tab. 

Set Cycle time under Distributed Clock. 

 

6.1.1.4 Module configuration parameter 

Double-click the added expansion module, and click the Startup Parameters tab. Startup parameters are 

SDO data, which are the initialization configuration parameters for each module. Double-click to modify the 

initial value. These parameters are transmitted to the slave during the EtherCAT communication transition 
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from Pre-OP to Safe-OP. For detailed parameter descriptions, see the "Software user interface" table of the 

respective module in section 5.5 I/O module. 

 

 

6.1.1.5 Module process data 

Double-click the added expansion module, and click the Module I/O Mapping tab. Double-click a link 

variable under Variable to obtain the sample value or control the output in the program. For detailed I/O 

data descriptions, see the "Software user interface" table of the respective module in section 5.5 I/O 

module. 
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6.1.1.6 Retrieving module fault status 

 

 

The coupler I/O mapping parameter ModuleStatus indicates the module fault status, as specified in the 

following table. 

Name Type Meaning 

ModuleStatus uint32_t (Unsigned 32-bit data) 

Module fault status (0: No fault; 1: Fault) 

Bit0: Fault status of module 1 

Bit1: Fault status of module 2 

... 

Bit31: Fault status of module 32 
 

A specific module fault code can be obtained by using the ETC_CO_SdoRead function block to read the 

corresponding sub index of Object Dictionary 16#3023. The definition of Object Dictionary 16#3023 is as 

follows. 

16#3023 

Module fault code information 

uint16_t sub index 1 Module 1 fault code 

uint16_t sub index 2 Module 2 fault code 

... ... 

uint16_t sub index 32 Module 32 fault code 
 

For detailed ETC_CO_SdoRead function block input/output descriptions, see the Codesys Help. 
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Procedure for retrieving module fault codes: 

1. Read the ModuleStatus data and check whether ModuleStatus.bit0 is equal to 1. If bit0 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 1). After the function block execution is completed without errors, Module 

1 fault code of can be obtained. Read the ModuleStatus data and check whether ModuleStatus.bit1 is 

equal to 1. If bit1 = 1, a fault is present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 2). After the function block execution is completed without errors, Module 

2 fault code of can be obtained. 

2. Read the ModuleStatus data and check whether ModuleStatus.bit2 is equal to 1. If bit2 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 3). After the function block execution is completed without errors, Module 

3 fault code of can be obtained. 

... 

32. Read the ModuleStatus data and check whether ModuleStatus.bit31 is equal to 1. If bit31 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 32). After the function block execution is completed without errors, Module 

32 fault code of can be obtained. 

Note: Enabling the SdoRead function block affects the real-time performance of EtherCAT communication. 

Therefore, do not continuously read module fault codes. First determine whether a module has a fault by 

checking ModuleStatus. The SdoRead function block should be enabled only when a fault is detected. 

Within a single task cycle, try to check only one module for faults, and do not retrieve fault codes for multiple 

modules within the same task cycle. 
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6.1.2 Sysmac Studio configuration description 

6.1.2.1 Installing the device description file 

Double-click EtherCAT, right-click Master device in the pop-up window, and choose Display ESI library. 

Click Install (File) in the pop-up ESI Library window, and locate the device description file for installation. 
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6.1.2.2 Setting the slave address 

When the coupler device is used for the first time, the slave node address must be configured. It is 

recommended to set the node address using the DIP switch on the coupler. When the coupler DIP switch is 

set to a non-zero value, the coupler node address is determined by the DIP switch setting. When the coupler 

DIP switch is set to 0, the coupler node address is configured by the PLC. The following briefly describes the 

method for configuring the node address via the PLC. 

Step 1 Once the device is connected, Click Online. Right-click Master device, and choose Write Slave Node 

Address. 
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Step 2 In the pop-up Slave Node Address Writing window, modify the setting (setting range: 1–192, unique), 

and click Write. 

 

Step 3 After the coupler is powered off and on again, verify that the coupling node address has been set 

successfully. If not, check whether the DIP switch is set to 0. 
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6.1.2.3 Performing network configuration 

 Manual configuration 

Step 1 Add EtherCAT Slave. 

In offline state, double-click EtherCAT and then Master Device, find the EtherCAT coupler with the 

invt label in the toolbar on the right, double-click the slave device to be added, and then modify the 

slave address. 

 

Note: The address of this slave address must be consistent with the one configured in section 

6.1.2.2 Setting the slave address. 
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Step 2 Add the expansion module. 

Click the coupler slave device that has been added, then click Edit Module Configuration in the 

configuration box on the right. Based on the actual physical connection of the modules, add the 

modules from the toolbar to the slots. 

 

 

 

 

Note: In this interface (node configuration interface), click Node9: FE-EC-Coupler(E001) (for example), 

and change Module Configuration Send Method to Send on the right configuration interface. If the 

network configuration is not modified, it will not be sent to the slave, and thus the slave cannot receive the 

network configuration, resulting in a configuration mismatch error. In addition, EtherCAT communication 

will also fail to enter the OP state. 
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Note: The physical configuration must be consistent with the network configuration. If the configuration 

is inconsistent, EtherCAT communication cannot enter the OP state. 

 Automatic scanning 

Click Online, right-click Master Device, choose Compare and Merge with Physical Network Configuration, 

and click Apply actual network configuration in the pop-up Compare and Merge with Physical Network 

Configuration window. 

 

 



FE Series I/O System User Manual  Coupler use instructions 

202601 (V1.0)  86 

 

Note: 

 After going offline, click Node n: Coupler device in the node configuration interface, and set Module 

Configuration Send Method to Send on the right configuration interface. If the network configuration 

is not modified, it will not be sent to the slave, and thus the slave cannot receive the network 

configuration, resulting in a configuration mismatch error. In addition, EtherCAT communication will 

also fail to enter the OP state. 

 It is recommended to check whether the network configuration and physical configuration added in 

automatic scan match, and adjustments can be made manually. 

6.1.2.4 EtherCAT communication parameter configuration 

Step 1 Set the synchronous mode: Double-click EtherCAT, click the added coupler device in the pop-up 

interface, and set Enable Distributed Clock to Enabled (DC-Synchron) on the right side. 
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Step 2 Set the synchronization cycle: The synchronization cycle and main task cycle are consistent. You only 

need to adjust the main task cycle. 

 

 

6.1.2.5 Module configuration parameter 

Testing indicate that only certain Omron PLC versions support visual configuration of initialization 

parameters. The testing results obtained using Omron Sysmac Studio V1.52 are as follows; other versions 

may vary depending on specific conditions. 

Omron 

host 

controller 

Model PLC version 
Support visual 

configuration 

NJ501 1300, 1400, 1500 
V1.40 and later Supported 

V1.21 and earlier Not supported 

NX701 1600, 1700 V1.21 and earlier Not supported 

NX1P2 9024DT, 1040DT, 1140DT 
V1.40 and later Supported 

V1.21 and earlier Not supported 
 

 Visual modification of initialization parameters 

Double-click the added module, Click Edit Setting Parameters on the right. Modify the module 

configuration parameters in the Edit Setting Parameters window. For detailed parameter descriptions, see 

the "Software user interface" table of the respective module in section 5.5I/O module. 



FE Series I/O System User Manual  Coupler use instructions 

202601 (V1.0)  88 

 

 

 

 Modifying initialization parameters via SDO function blocks 

If configuration parameters are all SDO parameters and the Omron PLC version does not support the visual 

configuration of initialization parameters, configure SDO parameters by using the EC_CoESDOWrite 

function block. 

Execute

SDO_Write

NodeAdr

object

1000

data

WriteSize

NodeAdr

Execute

EC_CoESDOWrite

SdoObj

TimeOut

WriteDat

Done

Busy

ErrorID

AbortCode

Error

WriteSize

Input 
variable

Input 
variable

Input 
variable

err
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Name Description 

Execute Rising edge active, and the rising edge enables the SDO Write function block. 

NodeAdr Node address 

SdoObj 

Object dictionary SDO parameter 

SdoObj.Index: Index 

SdoObj.Subindex: Subindex 

SdoObj.IsCompleteAccess: Indicates whether to access all indexes. 

TimeOut Timeout time 

WriteDat Data written 

WriteSize Write data size in bytes (1 byte = 8 bits) 
 

The index of each module configuration parameter can be viewed by importing the same configuration into 

the Invtmatic Studio (that can be downloaded at www.invt.com). In this software, the index and sub index of 

each configuration parameter can be checked. 

 

 

https://www.invt.com.cn/solutions/
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The delay before starting to write the SDO should be adjusted according to the actual situation; here, only a 

simple example is provided. 

CASE myStep OF 

 0://Configure the 1600D module filter parameter IB0 Filt to 10 (10ms) 

  NodeAdr : = 9; 

  object.Index : = 16#8030; 

  object.Subindex : = 16#01; 

  object.IsCompleteAccess : = 0; 

  data : = 10; 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 
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   myStep : = 1; 

  END_IF; 

 1://Configure the 1600DI module filter parameter IB0 Filt to 5 (5ms) 

  NodeAdr : = 9; 

  object.Index : = 16#8030; 

  object.Subindex : = 16#02; 

  object.IsCompleteAccess : = 0; 

  data : = 5; 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 

   myStep : = 2; 

  END_IF; 

 2://Configure the 8ADV module channel 0 configuration parameter AI0 Cfg 

  NodeAdr : = 9; 

  object.Index : = 16#81C1; 

  object.Subindex : = 16#01; 

  object.IsCompleteAccess : = 0; 

  data := 97; //-10–10V channel enable 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 

   myStep : = 3; 

  END_IF; 

 3://Configure the 8ADV module channel 0 configuration parameter AI0 Filt 

  NodeAdr : = 9; 

  object.Index : = 16#81C1; 

  object.Subindex : = 16#02; 

  object.IsCompleteAccess : = 0; 

  Data:= 7;//Filter parameter 7 //Median of every 7 samples 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 

   myStep : = 4; 

  END_IF; 

 4://Configure the 8ADV module channel 1 configuration parameter AI1 Cfg 

  NodeAdr : = 9; 

  object.Index : = 16#81C1; 

  object.Subindex : = 16#03; 

  object.IsCompleteAccess : = 0; 

  data := 1; //0–5V channel enable 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 

   myStep : = 5; 

  END_IF; 

 5://Configure the 8ADV module channel 1 configuration parameter AI1 Filt 
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  NodeAdr : = 9; 

  object.Index : = 16#81C1; 

  object.Subindex : = 16#04; 

  object.IsCompleteAccess : = 0; 

  Data:= 15;//Filter parameter 15 //Median of every 15 samples 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 

   myStep : = 6; 

  END_IF; 

 6://Configure the 4TC module channel 0 configuration parameter TC0 Cfg 

  NodeAdr : = 9; 

  object.Index : = 16#8248; 

  object.Subindex : = 16#01; 

  object.IsCompleteAccess : = 0; 

  data := 1; //Type K thermocouple channel enable 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 

   myStep : = 7; 

  END_IF; 

 7://Configure the 4TC module channel 0 configuration parameter TC0 Filt 

  NodeAdr : = 9; 

  object.Index : = 16#8248; 

  object.Subindex : = 16#02; 

  object.IsCompleteAccess : = 0; 

  Data:= 5;//Filter parameter 5 //Median of every 5 samples 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 

   myStep : = 8; 

  END_IF; 

 8://Configure the 4TC module channel 1 configuration parameter TC1 Cfg 

  NodeAdr : = 9; 

  object.Index : = 16#8248; 

  object.Subindex : = 16#03; 

  object.IsCompleteAccess : = 0; 

  Data: = 65;//Type J thermocouple channel enable 

  WriteSize  : = 1; 

  Execute : = 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute : = 0; 

   myStep : = 9; 

  END_IF; 

 9: 

  //do something  

  ; 

END_CASE; 
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6.1.2.6 Module process data 

After variable mapping is completed in the I/O Map window, the variables can be used by the program. For 

detailed I/O data descriptions, see the "Software user interface" table of the respective module in section 

5.5 I/O module. 

 

6.1.2.7 Retrieving module fault status 

 

The coupler I/O mapping parameter ModuleStatus indicates the module fault status, as specified in the 

following table. 

Name Type Meaning 

ModuleStatus uint32_t (Unsigned 32-bit data) 
Module fault status (0: No fault; 1: Fault) 

Bit0: Fault status of module 1 
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Name Type Meaning 

Bit1: Fault status of module 2 

... 

Bit31: Fault status of module 32 
 

A specific module fault code can be obtained by using the EC_CoESDORead function block to read the 

corresponding sub index of Object Dictionary 16#3023. The definition of Object Dictionary 16#3023 is as 

follows. 

16#3023 

Module fault code information 

uint16_t sub index 1 Module 1 fault code 

uint16_t sub index 2 Module 2 fault code 

... ... 

uint16_t sub index 32 Module 32 fault code 
 

For detailed EC_CoESDORead function block input/output descriptions, see the Help. 

 

Procedure for retrieving module fault codes: 

1. Read the ModuleStatus data and check whether ModuleStatus.bit0 is equal to 1. If bit0 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 1). After the function block execution is completed without errors, Module 

1 fault code of can be obtained. 

2. Read the ModuleStatus data and check whether ModuleStatus.bit1 is equal to 1. If bit1 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 2). After the function block execution is completed without errors, Module 

2 fault code of can be obtained. 

3. Read the ModuleStatus data and check whether ModuleStatus.bit2 is equal to 1. If bit2 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 3). After the function block execution is completed without errors, Module 

3 fault code of can be obtained. 

... 

32. Read the ModuleStatus data and check whether ModuleStatus.bit31 is equal to 1. If bit31 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 32). After the function block execution is completed without errors, Module 

32 fault code of can be obtained. 

Note: Enabling the SdoRead function block affects the real-time performance of EtherCAT 

communication. Therefore, do not continuously read module fault codes. First determine whether a module 

has a fault by checking ModuleStatus. The SdoRead function block should be enabled only when a fault is 
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detected. Within a single task cycle, try to check only one module for faults, and do not retrieve fault codes 

for multiple modules within the same task cycle. 

6.1.3 TwinCAT3 configuration description 

6.1.3.1 Installing the device description file 

Copy the coupler device description file (.xml) to the directory 

C:\TwinCAT\3.1\Config\Io\EtherCAT (the storage directory for TwinCAT EtherCAT device description files) 

and restart the TwinCAT software. 
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6.1.3.2 Performing network configuration 

 Manual configuration 

Step 1 Add the EtherCAT master. 

Right-click Device under I/O, and choose Add New Item. In the Insert Device window, choose 

EtherCAT Master, and click OK. Select the correct network port in the Device Found At window. 
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Step 2 Add the EtherCAT slave. 

Right-click EtherCAT under Device, and choose Add New Item. In the Insert EtherCAT Device 

window, locate the slave device you want to add, and click OK to add the EtherCAT slave device. 
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Step 3 Add slot devices. 

Double-click the added coupler slave device and click the Slots tab. Based on the physical 

configuration (actual physical connection sequence), correctly add the modules on the right to the 

slots on the left. 

Note: The physical configuration must be consistent with the network configuration. If the 

configuration is inconsistent, EtherCAT communication cannot enter the OP state. 

 

 

 Automatic scanning 

Step 1 Establish a reliable physical connection for Computer > PLC > Coupler slave, and switch the PLC to 

Config Mode. 
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Step 2 Right-click Devices under I/O, choose Scan, and click OK in the pop-up dialog box to wait for the scan 

results. Select the scanned devices as needed, and click OK. Click Yes in the pop-up Scan for boxes 

dialog box to wait for the scan results. 

Note: It is recommended to check whether the network configuration and physical configuration 

added in automatic scan match, and adjustments can be made manually. 
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6.1.3.3 EtherCAT communication parameter configuration 

Step 1 Set the synchronization mode: Double-click the added coupler, and click the DC tab. Set Operation 

Mode. 

 

Step 2 Set the synchronization cycle. 

Double-click I/O > Devices > EtherCAT, click the Adapter tab, and set Freerun Cycle (ms) 

(recommended to adjust). 

Double-click the added coupler slave device, click the DC interface, click Advanced Settings and set 

SYNC 0 > Sync Unit Cycle (not recommended to adjust). 
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6.1.3.4 Module configuration parameters 

Double-click the added coupler, and click the Startup tab. Startup parameters are SDO data, which are the 

initialization configuration parameters for each module. Double-click to modify the initial value. These 

parameters are transmitted to the slave during the EtherCAT communication transition from Pre-OP to 

Safe-OP. For detailed parameter descriptions, see the "Software user interface" table of the respective 

module in section 5.5 I/O module. 
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6.1.3.5 Module process data 

Linked variables are used for reading input samples or controlling outputs in the program. For detailed I/O 

data descriptions, see the "Software user interface" table of the respective module in section 5.5 I/O 

module. 

 

6.1.3.6 Retrieving module fault status 

 

The coupler I/O mapping parameter ModuleStatus indicates the module fault status, as specified in the 

following table. 

Name Type Meaning 

ModuleStatus 
uint32_t (Unsigned 32-bit 

data) 

Module fault status (0: No fault; 1: Fault) 

Bit0: Fault status of module 1 

Bit1: Fault status of module 2 

... 
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Name Type Meaning 

Bit31: Fault status of module 32 

A specific module fault code can be obtained by using the FB_EcCoESdoRead function block to read the 

corresponding sub index of Object Dictionary 16#3023. The definition of Object Dictionary 16#3023 is as 

follows. 

16#3023 

Module fault code information 

uint16_t sub index 1 Module 1 fault code 

uint16_t sub index 2 Module 2 fault code 

... ... 

uint16_t sub index 32 Module 32 fault code 
 

For detailed FB_EcCoESdoRead function block input/output descriptions, see the Help. 

 

Procedure for retrieving module fault codes: 

1. Read the ModuleStatus data and check whether ModuleStatus.bit0 is equal to 1. If bit0 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 1). After the function block execution is completed without errors, Module 

1 fault code of can be obtained. 

2. Read the ModuleStatus data and check whether ModuleStatus.bit1 is equal to 1. If bit1 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 2). After the function block execution is completed without errors, Module 

2 fault code of can be obtained. 

3. Read the ModuleStatus data and check whether ModuleStatus.bit2 is equal to 1. If bit2 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 3). After the function block execution is completed without errors, Module 

3 fault code of can be obtained. 

... 

32. Read the ModuleStatus data and check whether ModuleStatus.bit31 is equal to 1. If bit31 = 1, a fault is 

present. In this case, enable the SdoRead function block 

(Index = 16#3023, sub index = 32). After the function block execution is completed without errors, Module 

32 fault code of can be obtained. 

Note: Enabling the SdoRead function block affects the real-time performance of EtherCAT 

communication. Therefore, do not continuously read module fault codes. First determine whether a module 

has a fault by checking ModuleStatus. The SdoRead function block should be enabled only when a fault is 

detected. Within a single task cycle, try to check only one module for faults, and do not retrieve fault codes 

for multiple modules within the same task cycle. 
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6.2 PROFINET communication coupler 

6.2.1 TIA Portal configuration description 

6.2.1.1 Installing the device description file 

Install the device description file named in the format of GSDML-V2.43-INVT-FE-PN-xxxxxxxx.xml. 

 

In the window that appears, set Source path to the GSD file saving path, select the GSD file to be installed, 

and then click Install. 
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6.2.1.2 Configuring the PN device name 

Complete the actual physical connection. Under Project tree, choose Devices > Online access > Realtek 

PCle GbE Family Controller > Update accessible devices. 

 

Choose the refreshed PN coupler device (you can confirm the device according to the MAC address or the 

LED blinking status). Choose Online & diagnostics under Devices, choose Functions > Assign PROFINET 

device name, set the name, and click Assign name. 

Note: When Flash Lights is selected, the corresponding coupler RUN/ERR/SF indicators flash 

simultaneously. 
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6.2.1.3 Performing network configuration 

Add a coupler: Choose PLC_1 > Device configuration > Network view, click the hardware directory on the 

right, and choose Other field devices > PROFINET IO > I/O > INVT > PN IO System > FE Series > FE-PN to 

add it to the project. 
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Add a module: Choose PLC_1 > Device configuration > Network view, select the required FE-PN device in 

the Device view interface. Add the modules on the right to the slots according to the actual physical 

configuration. 

 

6.2.1.4 PROFINET communication parameter configuration 

Set the IP address: Select the PN device to configure in the Device view interface, and then choose 

Properties > General > Ethernet address, and set the IP address. 

 

Set the PROFINET device name: There are two FE-PN device name setting methods. 

Method 1 Set via a DIP switch. When the DIP switch is set to a non-zero value, the device name set via the 

DIP switch takes effect. For example, if the DIP switch is set to 129, the device name is fepn129. 
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Method 2 Set via the TIA Portal. When the DIP switch is set to 0, the device name set via the TIA Portal 

takes effect. Select the target PN device in the Device view interface, and then choose 

Properties > General > Ethernet address, and set the PROFINET device name. Clear Generate 

PROFINET device name automatically to freely set the device name. 

Note: The set PROFINET device name must be consistent with the device name as set in section 6.2.1.2 

Configuring the PN device name. When PN communication is established, devices match by device name. If 

device names are not consistent, devices cannot be recognized. 

 

Choose Properties > General > Advanced Options and set other parameters such as the I/O update cycle 

and network port rate. 
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6.2.1.5 Module configuration parameters 

Select the target PN device in the Device view interface, and then choose Properties > General > Module 

parameters > Configure Parameters, and set module parameters. 
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6.2.1.6 Module process data 

Read and write module process data via the I and Q addresses assigned in TIA Portal. For detailed module 

process data descriptions, see the "Software user interface" table of the respective module in section 5.5 I/O 

module. 

 

In the preceding figure, 

1. For the FE-0808N module, the I address is 4 and the Q address is 6. According to the "Software user 

interface" table in section 5.5.5 Mixed digital module (sinking) FE-0808N, address %IB4 corresponds to 

module input data IB0, and address %QB6 corresponds to module output data QB0. 

Type Name Type Default Description 

Configurat

ion 

parameter 

IB0 Filt uint8_t 3 [0, 255], unit: 1ms, e.g. 3 = 3ms 

QB0 Out Mode uint8_t 0 

Q00–Q07 output mode 

Bit0: Q00 output mode 

Bit1: Q01 output mode 

... 

Bit7: Q07 output mode 

0: Output preset; 1: Hold output 

QB0 Preset Value uint8_t 0 Q00–Q07 output preset values 

Input data IB0 uint8_t - I00–I07 sample values 

Output 

data 
QB0 uint8_t - Q00–Q07 output values 

 

2. For the FE-8ADI module, the I addresses range from 100 to 115. According to the "Software user 

interface" table in section 5.5.8 Analog input module FE-8ADI, address %IW100 corresponds to module 

input data AI0, address %IW102 corresponds to module input data AI1, ..., and address %IW114 

corresponds to module input data AI7. 

Type Name Type Default Description 

Input data 

AI0 int16_t - Channel sample code value 

AI1 int16_t - Channel sample code value 

AI2 int16_t - Channel sample code value 

AI3 int16_t - Channel sample code value 

AI4 int16_t - Channel sample code value 

AI5 int16_t - Channel sample code value 
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Type Name Type Default Description 

AI6 int16_t - Channel sample code value 

AI7 int16_t - Channel sample code value 

Output 

data 
- - - - 

 

3. For the FE-4TC module, the I addresses range from 132 to 147. According to the "Software user interface" 

table in section 5.5.11 Temperature detection module (thermocouple) FE-4TC, address %ID132 

corresponds to module input data TC0 (32-bit floating point), %ID136 corresponds to TC1, …, 

and %ID144 corresponds to TC3. 

Type Name Type Default Description 

Input data 

TC0 real32_t - Temperature sampling value 

TC1 real32_t - Temperature sampling value 

TC2 real32_t - Temperature sampling value 

TC3 real32_t - Temperature sampling value 

Output 

data 
- - - - 

 

6.2.1.7 Retrieving module fault status 

The FE-PN coupler is a standard PROFINET slave device and it is fully compatible with the full set of 

diagnostic functions available in the TIA Portal for PROFINET distributed I/O systems. Its diagnostic behavior 

is consistent with that of other PROFINET slave devices in the system. 

Viewing module faults online in TIA Portal: 

After going online with the PLC, select the target device in the Device view interface. Double-click the red 

wrench icon of the faulty module on the right. 

 

In the pop-up window, navigate to Diagnostics > Diagnostic status, where detailed fault information is 

displayed in the Standard diagnostics area. 
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Retrieving fault status in the program: 

In the TIA Portal, the DeviceStates instruction can be used to check whether the coupler device has a fault, 

and the ModuleStates instruction can be used to determine whether the module has a fault. The RDREC 

instruction can be used to read detailed module fault codes (RERDC[15] is the fault code described in 

section 8.1 Common faults and solutions). 

 

6.2.2 STEP 7-MicroWIN SMART configuration description 

6.2.2.1 Installing the device description file 

Install the device description file named in the format of GSDML-V2.43-INVT-FE-PN-xxxxxxxx.xml. 

 

 

In the pop-up window, select the source path where the GSD file is located. If a verification failed dialog 

appears, select Yes to continue. After installation, the configuration file information is displayed in the 

project. 
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6.2.2.2 Configuring the PN device name 

After completing the physical connection of the module, choose Tools > Find PROFINET Devices > Find 

Devices. 

 

 

Select the refreshed PN coupler device (the device can be located by pressing the Flash Lights button), click 

Edit, enter the device name, and click OK. 

Note: When Flash Lights is selected, the corresponding coupler RUN/ERR/SF indicators flash 

simultaneously. 
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6.2.2.3 Performing network configuration 

Add a coupler: Choose Tools > PROFINET, select Controller, enter the PLC network port information, and 

click Next. 

 

Drag the FE-PN device into the device table and configure the device name and IP address. 

There are two methods to set the FE-PN device name. 

 Set via a DIP switch. When the DIP switch is set to a non-zero value, the device name set via the DIP 

switch takes effect. For example, if the DIP switch is set to 129, the device name is fepn129. 

 Set via the STEP 7-MicroWIN SMART. When the DIP switch is set to 0, the device name set via the STEP 

7-MicroWIN SMART takes effect. 
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Note: The set PROFINET device name must be consistent with the device name as set in section 6.2.2.2 

Configuring the PN device name. When PN communication is established, devices match by device name. If 

device names are not consistent, devices cannot be recognized. 

 

 

Add modules: Choose modules on the right, click Add or drag to add to the table. After you add the modules 

based on the actual configuration, click Next to configure the modules in order. The module configuration 

window can also be accessed by clicking directly on the module on the left. 

 

6.2.2.4 Module configuration parameter 

Using FE-4ADM as an example, select the corresponding module on the left, modify the configuration 

parameters, and click Generate. 
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6.2.2.5 Module process data 

Read and write module process data via the I and Q addresses assigned in STEP 7-MicroWIN SMART. For 

detailed module process data descriptions, see the "Software user interface" table of the respective module 

in section 5.5 I/O module. 

 

As shown in the preceding figure, for the FE-0808N module in slot 11, the I address is 211 and the Q address 

is 141. According to the "Software user interface" table in section 5.5 I/O module, address %IB211 

corresponds to module input data IB0, and address %QB141 corresponds to module output data QB0. 

Type Name Type Default Description 

Configuration 

parameter 

IB0 Filt uint8_t 3 [0, 255], unit: 1ms, e.g. 3 = 3ms 

QB0 Out Mode uint8_t 0 
Q00–Q07 output mode 

Bit0: Q00 output mode 
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Type Name Type Default Description 

Bit1: Q01 output mode 

... 

Bit7: Q07 output mode 

0: Output preset; 1: Hold output 

QB0 Preset Value uint8_t 0 Q00–Q07 output preset values 

Input data IB0 uint8_t - I00–I07 sample values 

Output data QB0 uint8_t - Q00–Q07 output values 
 

6.2.2.6 Retrieving module fault status 

 When a power supply fault occurs on 0808DN 

Click PLC under the PLC directory, and click the PN device name fepn. You can monitor the module status 

faults, and corresponding fault information is also available in Event logs and PROFINET alarms. 

Special memory: When the 11th 0808N module has a power supply fault, SMB1800 = 16#82 and SMB1809.3 = 

1. 

 

 

After clearing the module fault, the errors in fepn and PRIFINET alarms are cleared; the event log remains 

unchanged; the error value in the special memory is set to zero. 

 When the PN device is disconnected 

Click PLC under the PLC directory, and click the PN device name fepn. You can monitor the device status 

faults and corresponding fault information is also available in Event logs and PROFINET alarms. 
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7 Ttools-IO operating instructions 

7.1 Overview 

This chapter describes the use of the host commissioning tool to ensure stable and reliable operation of the 

I/O system, and to facilitate rapid identification and resolution of issues during commissioning and 

operation. This content is intended for commissioning engineers, system integrators, and maintenance 

engineers with basic knowledge of automation systems. 

7.2 Coupler series selection 

 

When starting the software, select the corresponding option for the coupler series to be connected, and 

click Next to load the interface for that series. 

The switching function of the coupler M key is described as follows: 

Procedure for entering the host configuration mode: 

Method 1 Press and hold the M key before power-on. After the power-on, release the M key when all 

indicators (except the Power indicator) flash simultaneously to enter the host configuration 

mode. 

Method 2 After the coupler is operating normally, press and hold the M key until all indicators (except 

the Power indicator) flash simultaneously, then release the key to enter host PC configuration 

mode. 

How to enter the normal mode: 

Method 1 Power on without pressing the M key. The normal mode is entered. 

Method 2 There are two ways to enter the normal mode from the host configuration mode: one is to 

re-power on without pressing M; the other is to press and hold M until all status indicators 

(except the Power indicator) flash simultaneously, then release the key so that the coupler 

performs a software reset and enters the normal mode. 

To enter the TTools-IO configuration mode from the normal mode, refer to the procedures described above 
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for entering the host configuration mode. 

7.3 Module identification and project configuration 

7.3.1 Creating and opening a project 

 Creating a project 

Step 1 Click New Project in the menu bar. The New Project window is displayed. 

Step 2 Enter the project name and select the save path, and click OK. A project is created. 

 

 Opening a project 

Step 1 Choose File > Open Project. 
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Step 2 In the dialog that appears, select the project to open and click Open to load the project. 

 

7.3.2 Module scan and configuration verification 

Click Device Scanning. In the Device Scanning window, select the network adapter connected to the 

coupler, then start scanning for devices. Currently, only a single-coupler configuration is supported. After 

the device IP address is discovered, connect to the corresponding device. If the connection is successful, the 

corresponding area is displayed in light green. Then click Get Config. The coupler and I/O module can be 

loaded. 
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After the scan is complete, you can click the Load button to load it into the project, thereby creating a 

project that can be saved and facilitating subsequent operations such as parameter editing and download. 
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7.3.3 Module management 

 Adding a module 

To add a module, double-click the corresponding module in the device library or drag the module into the 

software view. 
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 Adjusting module order 

When a module is selected in the project tree, the module order can be adjusted using the Up and Down 

arrow keys. 

When a module is selected in the installation information configuration window, the module order can be 

adjusted using the Left and Right arrow keys or using the right-click shortcut menu. 

 

 Deleting a module 

When a module is selected in the project tree, the module can be deleted using the keyboard Delete key or 

using the right-click shortcut menu. 

When a module is selected in the installation information configuration window, the module can be deleted 

using the right-click shortcut menu. 
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7.4 Parameter configuration and download 

 Editing parameters 

After selecting a module or installation information in the project tree, click the Configuration Parameters 

tab to edit the module's parameters. 

Save the project promptly after completing the edits to prevent data loss. 

 

 Downloading project parameters 

In the project tree, select the coupler to which you want to download parameters. Click Download Project 

in the menu bar to download the parameters to the coupler. If the operation is successful, a message box is 

displayed. 

 

If the selected coupler is not configured with a connection method, the Network Device Connection 

window appears. After configuration, it continues with parameter download; upon successful completion, a 

message box is displayed. 



FE Series I/O System User Manual  Ttools-IO operating instructions 

202601 (V1.0)  126 

7.5 Firmware management and log monitoring 

7.5.1 Coupler and module firmware upgrade 

Choose Firmware Upgrade from the menu bar, and select the target device in the window that appears. If 

the IP address does not connect automatically, check whether the device is connected correctly and the IP 

address is configured in the same subnet. If the device has been configured, the connected IP address is 

automatically loaded when the interface is displayed. If the connection is disconnected after being 

established, reconnect the device as illustrated in the figure. 

 

Module firmware upgrade supports batch operation only for modules of the same type. After the upgrade, a 

power cycle is required. Module firmware upgrade is performed on the modules connected downstream of 

the coupler. Choose Firmware Upgrade > Module Firmware Upgrade from the menu bar. Follow the 

prompts to connect the coupler, select the corresponding serial port, and retrieve the physical configuration 

for display in the interface. 
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7.5.2 Log viewing and updating 

 Viewing logs 

Logs record operational events such as parameter changes and module connections. 

 

 Checking for updates 

You can find the latest version information online under About Ttools-IO. 

 

If an update is available, you will be prompted to update. Follow the on-screen instructions to download 

and install. 
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7.6 Online monitoring and signal diagnostics 

7.6.1 Starting and exiting online monitoring 

 Starting online monitoring 

Right-click the coupler in the project tree and choose Online to start online monitoring. 

 

If no communication is established for the device, a connection dialog box appears for you to set the 

connection type. 
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After selecting the module to monitor, you can view the corresponding actual values in the Value column. 

 

 Exiting online monitoring 

Right-click the coupler/module in the project tree and choose Offline to stop online monitoring. 

 

7.6.2 Data reading and signal verification 

In online mode, select the module to view the real-time status values of input and output. 
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7.7 Typical commissioning cases 

✅Case 1: The system cannot enter the OP state after module replacement 

Symptom: 

After a DO module is replaced, the communication coupler RUN indicator flashes after system startup, and 

the system fails to enter the OP state. 

Troubleshooting process: 

1. Checking object dictionary 0xF050 shows that the actual identification code of slot 1 has changed. 

2. The identification code is compared with the 0xF030 identification code configured on the master, and 

a mismatch is found. 

3. Check whether the module model has been replaced. 

Solution: 

 Rescan the module configuration on the master. 

 Verify that the identification code has been updated. 

 Write the new configuration identification code to 0xF030. 

 Download the configuration and perform a power cycle. 

✅Case 2: Incorrect module order results in configuration validation failure 

Symptom: 

After the project is downloaded, the system reports an error. The communication coupler SF indicator 

flashes, and the module operation fails. 

Troubleshooting process: 

1. Check object dictionary 0xF050 and verify that the identification code order of the modules in slots 2 

and 3 does not match the expected configuration. 

2. Check whether the actual installation order is inconsistent with the configuration in the master project, 

indicating that the module positions are reversed. 

Solution: 

 Remove the modules and adjust their physical order to match the project configuration. 

 Ensure a one-to-one correspondence between the slot positions and the configuration indices 

(0xF030). 

 Restart the coupler, after which the system successfully enters the OP state. 

✅Case 3: Module scan failure results in an empty identification code 

Symptom: 

The master fails to scan the modules. The log indicates that identification codes are missing for some slots, 

and the corresponding sub index values in object dictionary 0xF050 are 0x00000000. 

Troubleshooting process: 

1. Check the connection status of the downstream modules connected to the communication coupler. 

2. Check the power supply output and find that the supply voltage is below 18V, preventing the modules 

from powering on properly. 

3. Replace the power supply, after which normal operation is restored. 

Solution: 

 Ensure that the power supply output is ≥ 24V and remains stable. 

 Power on the system again, allowing the identification codes to be automatically written to 0xF050. 

Rescan the modules on the master and update the configuration. 
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8 Troubleshooting 

For the method of retrieving module faults, refer to the respective master station fault retrieving sections in 

chapter 6 Coupler use instructions. 

8.1 Common faults and solutions 

Fault 

code 

(decimal) 

Fault code 

(hexadecimal) 
Fault type Solution 

General module fault 

1 0x0001 
Module configuration 

fault 

Check whether the network configuration 

corresponds to the physical configuration of 

the module 

2 0x0002 
Incorrect module 

parameter setting 

Check whether the module parameter 

settings are correct; reconfigure as described 

in the manual. 

3 0x0003 
Module output port 

power supply fault 

Measure the supply voltage at the module 

output port to check whether it is normal. 

Check whether the power supply module or 

the wiring is loose or disconnected. 

4 0x0004 Module output fault 

Check whether the load connected to the 

module output port exceeds the rated 

specifications. 

Parameter configuration fault 

18 0x0012 
Incorrect parameter 

setting for channel 0 

Check whether the parameter settings for 

channel 0 are within the permissible range; 

reconfigure as described in the manual. 

34 0x0022 
Incorrect parameter 

setting for channel 1 

Same as above; check the parameter 

configuration for channel 1. 

50 0x0032 
Incorrect parameter 

setting for channel 2 

Same as above; check the parameter 

configuration for channel 2. 

66 0x0042 
Incorrect parameter 

setting for channel 3 

Same as above; check the parameter 

configuration for channel 3. 

82 0x0052 
Incorrect parameter 

setting for channel 4 

Same as above; check the parameter 

configuration for channel 4. 

98 0x0062 
Incorrect parameter 

setting for channel 5 

Same as above; check the parameter 

configuration for channel 5. 

114 0x0072 
Incorrect parameter 

setting for channel 6 

Same as above; check the parameter 

configuration for channel 6. 

130 0x0082 
Incorrect parameter 

setting for channel 7 

Same as above; check the parameter 

configuration for channel 7. 

Output fault 

20 0x0014 Output fault on channel 0 

Measure the output terminal voltage/current 

of channel 0 to check whether it is normal. 

Check whether the load is short-circuited 

(resistance too low) or open-circuited 
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Fault 

code 

(decimal) 

Fault code 

(hexadecimal) 
Fault type Solution 

(disconnected). 

36 0x0024 Output fault on channel 1 
Same as above; check the output of channel 

1. 

52 0x0034 Output fault on channel 2 
Same as above; check the output of channel 

2. 

68 0x0044 Output fault on channel 3 
Same as above; check the output of channel 

3. 

84 0x0054 Output fault on channel 4 
Same as above; check the output of channel 

4. 

100 0x0064 Output fault on channel 5 
Same as above; check the output of channel 

5. 

116 0x0074 Output fault on channel 6 
Same as above; check the output of channel 

6. 

132 0x0084 Output fault on channel 7 
Same as above; check the output of channel 

7. 

Signal source open-circuit fault 

21 0x0015 
Signal source open circuit 

fault on channel 0 

Check whether the physical connection of the 

signal source (such as sensors or input 

devices) for channel 0 is secure, and eliminate 

any open-circuit conditions. 

37 0x0025 
Signal source open circuit 

fault on channel 1 

Same as above; check the signal source for 

channel 1. 

53 0x0035 
Signal source open circuit 

fault on channel 2 

Same as above; check the signal source for 

channel 2. 

69 0x0045 
Signal source open circuit 

fault on channel 3 

Same as above; check the signal source for 

channel 3. 

85 0x0055 
Signal source open circuit 

fault on channel 4 

Same as above; check the signal source for 

channel 4. 

101 0x0065 
Signal source open circuit 

fault on channel 5 

Same as above; check the signal source for 

channel 5. 

117 0x0075 
Signal source open circuit 

fault on channel 6 

Same as above; check the signal source for 

channel 6. 

133 0x0085 
Signal source open circuit 

fault on channel 7 

Same as above; check the signal source for 

channel 7. 

Sampling signal out-of-range fault 

22 0x0016 

Sampling signal limit 

exceeding fault on 

channel 0 

Check whether the sampling signal of channel 

0 exceeds the maximum or minimum input 

value permitted by the chip. Adjust the signal 

source or the attenuation circuit accordingly. 

38 0x0026 

Sampling signal limit 

exceeding fault on 

channel 1 

Same as above; check the sampling signal of 

channel 1. 

54 0x0036 

Sampling signal limit 

exceeding fault on 

channel 2 

Same as above; check the sampling signal of 

channel 2. 

70 0x0046 
Sampling signal limit 

exceeding fault on 

Same as above; check the sampling signal of 

channel 3. 
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Fault 

code 

(decimal) 

Fault code 

(hexadecimal) 
Fault type Solution 

channel 3 

86 0x0056 

Sampling signal limit 

exceeding fault on 

channel 4 

Same as above; check the sampling signal of 

channel 4. 

102 0x0066 

Sampling signal limit 

exceeding fault on 

channel 5 

Same as above; check the sampling signal of 

channel 5. 

118 0x0076 

Sampling signal limit 

exceeding fault on 

channel 6 

Same as above; check the sampling signal of 

channel 6. 

134 0x0086 

Sampling signal limit 

exceeding fault on 

channel 7 

Same as above; check the sampling signal of 

channel 7. 

Sampling signal overrange (upper limit) fault 

23 0x0017 

Sampling signal 

measurement upper limit 

exceeding fault on 

channel 0 

Check whether the sampled value of channel 

0 exceeds the configured upper limit. Adjust 

the measurement range or the signal source 

output accordingly. 

39 0x0027 

Sampling signal 

measurement upper limit 

exceeding fault on 

channel 1 

Same as above; check the sampling signal of 

channel 1. 

55 0x0037 

Sampling signal 

measurement upper limit 

exceeding fault on 

channel 2 

Same as above; check the sampling signal of 

channel 2. 

71 0x0047 

Sampling signal 

measurement upper limit 

exceeding fault on 

channel 3 

Same as above; check the sampling signal of 

channel 3. 

87 0x0057 

Sampling signal 

measurement upper limit 

exceeding fault on 

channel 4 

Same as above; check the sampling signal of 

channel 4. 

103 0x0067 

Sampling signal 

measurement upper limit 

exceeding fault on 

channel 5 

Same as above; check the sampling signal of 

channel 5. 

119 0x0077 

Sampling signal 

measurement upper limit 

exceeding fault on 

channel 6 

Same as above; check the sampling signal of 

channel 6. 

135 0x0087 

Sampling signal 

measurement upper limit 

exceeding fault on 

channel 7 

Same as above; check the sampling signal of 

channel 7. 

Sampling signal underrange (lower limit) fault 
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Fault 

code 

(decimal) 

Fault code 

(hexadecimal) 
Fault type Solution 

24 0x0018 

Sampling signal 

measurement lower limit 

exceeding fault on 

channel 0 

Check whether the sampled value of channel 

0 is below the configured lower limit. Adjust 

the measurement range or the signal source 

output accordingly. 

40 0x0028 

Sampling signal 

measurement lower limit 

exceeding fault on 

channel 1 

Same as above; check the sampling signal of 

channel 1. 

56 0x0038 

Sampling signal 

measurement lower limit 

exceeding fault on 

channel 2 

Same as above; check the sampling signal of 

channel 2. 

72 0x0048 

Sampling signal 

measurement lower limit 

exceeding fault on 

channel 3 

Same as above; check the sampling signal of 

channel 3. 

88 0x0058 

Sampling signal 

measurement lower limit 

exceeding fault on 

channel 4 

Same as above; check the sampling signal of 

channel 4. 

104 0x0068 

Sampling signal 

measurement lower limit 

exceeding fault on 

channel 5 

Same as above; check the sampling signal of 

channel 5. 

120 0x0078 

Sampling signal 

measurement lower limit 

exceeding fault on 

channel 6 

Same as above; check the sampling signal of 

channel 6. 

136 0x0088 

Sampling signal 

measurement lower limit 

exceeding fault on 

channel 7 

Same as above; check the sampling signal of 

channel 7. 

Hardware fault 

257 0x0101 
Module hardware fault - 

SPI timeout 
Contact the manufacturer. 

258 0x0102 

Module hardware fault - 

Output Ready not 

asserted 

Contact the manufacturer. 
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9 Inspection and maintenance 

9.1 Daily inspection and regular maintenance 

The machine internal components will become aging due to the influence of environmental temperature, 

humidity, dust, vibration and other factors, which causes the potential failure or shortens the service life. 

Therefore, to extend the machine service life and prevent safety hazards, daily inspection and regular 

maintenance are required. 

Check item Content Method 

Daily inspection: Recommended on each day. 

Ambient 

environment 

Whether the ambient temperature, humidity, 

vibration, dust, gas, and oil are too great, and 

whether there is condensation or water droplets 

inside and outside the machine 

Visual inspection and 

instrument measurement 

Whether there are foreign matters, such as tools, or 

dangerous substances placed nearby 
Visual inspection 

Power voltage Check whether supply voltage is abnormal. 
Multimeter or voltage 

meter 

Indicator 

Whether display is clear Visual inspection 

Whether some characters or fields are displayed 

incompletely 
Visual inspection 

Regular maintenance: Recommended on a quarterly basis, especially in harsh environments 

such as with dust, oil, or corrosive gases. Before regular maintenance, cut off the power and 

wait at least 15min. 

Entire machine 

Check whether the DIN rail fixing clip is loose. Visual inspection 

Check whether the machine is deformed, cracked, or 

damaged, or the color changes due to overheating 

and aging. 

Visual inspection 

Check whether much dirt or dust is attached. Visual inspection 

Check for abnormal noise, vibration, odor, or 

discoloration. 

Auditory, olfactory, and 

visual inspection 

Cable 

Check whether there is discoloration, deformation, 

or damage. 
Visual inspection 

Check whether the cables are loose. Visual inspection 

Connection 

terminals 

Check for overheating or damage. 

Check whether the terminals are secure and not 

loose. 

Visual inspection, 

instrument based 

inspection 

Contactor and relay 

Check whether there is vibration sound during 

running. 
Auditory inspection 

Check whether the contacts are in good contact. Visual inspection 

Ventilation duct 
Check whether there are foreign matters blocking or 

attached to the cooling fan, air inlets, or air outlets. 
Visual inspection 

 

For more details about maintenance, contact the local INVT office, or visit our website https://www.invt.com, 

and choose Support > Services. 

 

https://www.invt.com/
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Appendix A Product dimensions 

A.1 Communication coupler 

A.1.1 Module installation dimensions 

Figure A-1 Module installation dimensions (unit: mm) 
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A.1.2 Connection cable dimensions 

Figure A-2 Connection cable dimensions (unit: mm) 
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A.1.3 End cover dimensions 

Figure A-3 End cover dimensions (unit: mm) 
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A.2 I/O module 

A.2.1 Module installation dimensions 

Figure A-4 Module installation dimensions (unit: mm) 
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A.2.2 Connection cable dimensions 

The dimensions are applicable to all I/O module models. 

Figure A-5 Connection cable dimensions (unit: mm) 
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